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Need Help?
There are many ways to get help with Mechanical Expressions.
In both the PDF manual document and the embedded Help system you
can:
·

Use the table of contents to get details on using a tool, an icon or a
menu.

·

Use the index for help on a particular topic, such as "parametric
equations".

Inside the Mechanical Expressions Help system you can:
·

Use the Search tool to find all topics based on a key word, such as
"constraints".

·

Browse through help with the up - "Previous page", and down - "Next
Page" arrows
logical sequence.

·

. This will step you through the help subtopics in a

You can click on colored text which links you to more information.

Tool Tips:
When you move the cursor over any icon on the screen, the name of the
icon appears briefly below the cursor.

Linked Text
Some words in the program's Help system are highlighted and underlined.
When you place the cursor over this text, the cursor becomes the hand
symbol. This text indicates a link to more information on the subject. Click
the text to jump to the related help page.
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Many of the menu items in the drop down menu bar at the top of the
screen correspond to one of the icons or buttons across the top of the
display window or in one of the toolboxes.
Icons across the top of the screen comprise the standard Windows File,
Edit, View and Help commands. The construction and calculation tools
are displayed along the side of the drawing window. These toolboxes can
be displayed on the left or right panel, top or bottom panel, floating in a
separate window, or hidden.
The output window can be displayed below the drawing window to show
large expressions.
The status bar at the bottom of the window displays the following (from
left to right):
<Menu Help> <Current Mode> <Cursor Coordinates> <Angle Mode>
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The Status Bar
The status bar at the bottom of the screen prompts the following
information (from left to right):

·

Menu Help - summary of a selected menu item.

·

Current Mode - Each icon in the drawing toolbox represents a mode.
Tools requiring additional inputs after clicking the tool will display
further prompts in this field.

·

Cursor Coordinates - Displays the current coordinates of the cursor
in the diagram.

·

Angle Mode - A drop down window for conveniently changing from
Radians to Degrees and visa versa. This default can also be changed
in the Preferences dialog - Edit / Preferences / Math.
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You can arrange the display as it suits you.
Arranging Toolboxes - Anchored or floating toolboxes can be
placed around the drawing window.
Hide / Show Toolboxes - You may want to hide toolboxes which
you rarely use.
Saving your configuration - Use the View / Tool Panel
Configurations.
Arranging projects - You can open multiple project files and
arrange them in the drawing window using the page tabs.
In the example below three toolboxes (Draw, Constrain (Input), and
Construct) are anchored, four (Calculate (Output), Variables,
Mechanics Input and Mechanics Output) are floating, and three (
Annotate, Symbols and Annotation Symbols) are hidden. Two slightly
different locus examples are displayed for comparison.
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Arranging Toolboxes
You can move the toolboxes around the periphery of the drawing window
by clicking the title bar and dragging.
Click the pushpin on the upper right corner of individual toolboxes to make
it a "floating" box that you can drag anyplace on the screen. Floating
boxes have a colored title bar -
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To re-anchor the toolbox, drag the box until a blue shadow appears at the
position where you want it, then release the mouse button. You may want
to readjust the screen size for optimal viewing.

Hiding / Showing Toolboxes
Use the X on the upper right corner of individual toolboxes to hide them.

To display a hidden toolbox, select View / Tool Panels. The submenu
lists the toolboxes and the Main Toolbar (the icon strip at the top of the
window). Boxes shown are preceded by a check, those without a check are
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hidden.

Click a toolbox name to change its state.

Saving the Configuration
After configuring the screen to you preference, you can save this
arrangement in case it gets messed up, or perhaps you need the tools
arranged differently for different projects. This is easy with the View /
Tool Panel Configurations menu selection. You can give a name to an
arrangement of the toolbars. Several configurations can be saved in a list
and referred to as needed.
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Add - to save the current screen configuration. You will be prompted for
a name to reference this configuration.
Delete - if you no longer will use a certain configuration you can delete it
from your list.
Set - to change a configuration which you have saved, simply select the
configuration name from your list. Check out the configurations that
come with the program.

Default - reset tool panels back to the default configuration.

Arranging Project Pages
You can open multiple project files for quick reference. By default files are
overlaid. Click a page tab to bring a file to the top.
Comparing drawings side by side - click the page tab and drag it to
one side, top, or bottom of the window. A shadow of the drawing gives
you an indication of how the drawings will be arranged before you release
the mouse button.
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Returning to overlaid configuration - drag one tab and position it over
the other tab. The shadow will appear only on the title bar, then release
the mouse button.
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Select Preferences from the Edit menu (or in the Mac version,
Mechanical Expressions / Preferences...) to modify the program's
general defaults. Mechanics defaults are set separately under Edit /
Mechanics Environment.
The default settings are grouped by type, listed on the left side of the
Preferences dialog. Click the icon to display the desired page.
These settings are also available for editing a selected object or group
of objects individually without changing the defaults, using the
Selection Context Menu.
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set the line color and style for each selection type.

set font related properties for labels; color and size /
style for other geometric elements.
set font properties for text, the rotation angle and the
transparency level of an inserted picture, and the Pinned
state for Text and Pictures. Pinned Text and Pictures
will not move relative to the Page Boundaries as the
result of a Scale operation.
set the properties for alphanumeric input and output;
mathematical calculation defaults.

set properties of the Major and Minor Grid, the
coordinate Axes, the drawing's background color, and
the Page Boundary lines.
set font related properties for mechanics input and
output expressions; color and size / style for other
mechanics elements.
To see the possible values for each property, click the row. An icon will
appear at the right end of the row (except the Point Size selection under
the Font property -you can enter the point size directly).

Click the icon to display the selection dialog
choices
.
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Changing a default for a type of drawing entity will apply to all entities of
that type except ones whose properties have been individually set, by
selecting it and then choosing Edit / Properties or right clicking All
Properties from the Selection Context menu. Likewise, text, pictures
or expressions that were individually pinned

or unpinned

will not be affected by changes to the default Pinned settings.

Changing Background Color
You can now change the drawing's background color to something other
than white with the following steps:
1. Select Edit / Preferences... (or in the Mac version, Mechanical
Expressions / Preferences...)
2. Click the Grid, Axis, Page tab
3. Change the Fill Color in the Background section. The color will be
applied to all pages.
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You can change the drawing's background color for a particular file by
open the file, right click on the screen (without anything highlighted), then
select "Display Properties...", and then change the color.

© 2014 Saltire Software

V
Setting the Mechanics Environment

34

Mechanical Expressions Manual

To set the Mechanics Environment defaults select Edit / Mechanics
Environment.

System - Choices for the system units are:
·

SI (m/kg/sec)

·

CGS (cm/kg/sec)

·

FPS (ft/lbs/sec)

·

IPS (in/lbs/sec)

·

Custom - set the Gravity Value and the Gravitational Units check
box.

To select the System units,click the row and the arrow icon
the drop down menu of choices.

to display

To change any of the following entries, select the value and retype it.
Gravity Variable - g is a reserved word for the gravitational constant
(unless you replace it with another symbol). Do not use this symbol for
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any other variable.
Gravity Value - set to the gravitational constant (9.8, or a value you can
change if you are working in Custom System units)
Time Variable (tau) is a reserved word for time (unless you replace
it with another symbol). Do not use this symbol for any other variable.
By default
is set to 0. You can change this value in the Variables
toolbox.
Differential Equation Prefix - choose a prefix for the equations of
motion for the Differential Equations function provided in the
Mechanics Output menu.
Angle To Horizontal - the default is pi/2, viewing the model from the
side with gravity acting straight down. A horizontal model, (angle 0 to
horizontal), would view the model from the top and have no gravitational
force.
Gravitational Units - when working with standard system units, this
selection is grayed and the check box is set by the system: checked when
working with weight units (FPS and IPS), cleared when working in mass
units (SI and CGS). You can change the entry when working in Custom
units.
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Mechanical Expressions uses standard Windows file Open and Save
operations. Save your files regularly with the handy
the screen.

icon at the top of

The data files generated from your drawings will have the extension ".
mx".
You may create multiple data files and have them open in a session. By
default, each file is on separate page with the tabs across the top of the
drawing window. Click the tab to view the file.
If you are preparing a multi-paged lesson, you can save the pages
together as a Workbook, with the file extension ".mxw". This is a
completely separate file from the .mx files.
The Open / Save (As) / Close Workbook file selections apply only to the
workbook.
and the File / Save commands will NOT save the
workbook files. They only affect the individual .mx files.
Files can also be arranged for comparison viewing.
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Wookbooks and Individual .mx Files
Workbooks are a handy way of putting lessons together.
·

You can make a workbook by opening new tabs (File / New).

·

You can Open .mx files that you have already created to make them
part of your workbook.

·

You can create pages from a combination of the above.

When all of the pages are together on the page tab bar, select Save
Workbook (As) from the file menu.
Note: saving the workbook does NOT update any of the individual .mx
files displayed in the workbook, since the workbook file is an entirely
separate file (.mxw). If you want to keep the individual .mx file up to date
with the workbook page, you must use the regular File / Save for each
page / file. But, if you forget, you can always save it from the workbook
at any time.
Likewise, saving an individual page, File / Save, of an open workbook
does NOT update the workbook file (.mxw). However, if you forget to
save the workbook, but save a page (.mx), you can always open the .mx
file again from your open workbook file and resave the workbook.
If you don't want to keep individual copies of all your workbook pages,
then you just have to remember to use the Save Workbook file
selection.
However, to give the workbook pages custom names (instead of
unnamed7.mx), you must save the individual page (for example, Lesson 1
Ellipse.mx) at least once. After the first time, you don't need to continue
to save the .mx file.
Only one workbook file can be open at a time. If you open a workbook file
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while other individual files or another workbook file is open, they will be
closed, after, of course, prompting you to save them if you have made
changes.
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All mathematical expressions in Mechanical Expressions are written in
MathML, so you can copy and paste directly to or from any other MathML
program.
Usually the standard Edit / Copy or Ctrl-C command should work. If this
doesn't give you the desired result, try the Edit / Copy As command.
Select from the submenu of choices appropriate to your application.
If you copy an expression that uses Intermediate Variables, the algebra
system will create a function from the pasted expression.
To Paste math into Mechanical Expressions it must be Content MathML.
·

Maple creates Content MathML by default.

·

To create Content MathML in Mathematica v6.0, execute the following
commands:
SetOptions[XML`MathML`ExpressionToMathML, "NamespacePrefixes"
> {}, "Formats" > {"ContentMathML"}]
SetOptions[XML`MathML`BoxesToMathML, "NamespacePrefixes" > {},
"Formats" > {"ContentMathML"}]
SetOptions[Export, ConversionOptions > {"NamespacePrefixes" > {},
"Formats" > {"ContentMathML"}}]
SetOptions[ExportString, ConversionOptions > {"NamespacePrefixes"
> {}, "Formats" > {"ContentMathML"}}]

·

To create Content MathML in Mathematica v7.0 or higher, execute
the following commands
ExportString[expression, “MathML”, “Presentation”-> False, “Content”
-> True]
Then copy the content MathML representation (the exported
mathematical expression) as Plain Text and paste it into Mechanical
Expressions.
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Your installation comes with several examples - look in the Examples
subdirectory. For step by step instructions through some example sets,
see Mechanical Expressions Examples.pdf which can be found under the
Doc subdirectory in your Mx installation.
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Drawing

Using the Drawing Tools
The Draw toolbox contains the drawing commands and the Selection
Arrow. The drawing commands can also be invoked from the Draw menu.

Unlike commands in the other toolboxes, Drawing commands are always
available and require no pre-selection. Many of the commands are active
until you change to a different one or press the Esc key or click the
selection arrow
, e.g. you can make multiple points until you select
another tool or press esc. The selection mode, indicated by the selection
arrow cursor,
, is used for invoking all other commands. You can find
the active command mode by noting which button is pressed or looking at
the current mode on the status bar.

Point

Line
Segment

Infinite
Line

Vector

Polygon

Circle

Ellipse

Parabola

Hyperbola

Arc

N-gon

Curve
Approximation

Text

Picture

Expression

Function
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Before you start your drawing, select Edit / Preferences / Geometry to
set various attributes, such as line color / style, fill color / style and
transparency level, of the various drawing elements.
You can change the attributes of individual drawing elements by selecting
them, right click the mouse, and choose All Properties from the context
menu.

Adding a Point

To insert a point in your drawing, follow these steps:
1. Click the Point icon
the Draw menu.
2. Move the crosshairs

in the Drawing toolbox or select Point from

into position.

3. Click the mouse to place the point under the crosshairs.
When the crosshairs are positioned over some geometry an incidence
symbol (bowtie) is displayed around the point and the geometry is
highlighted. A click of the mouse will create the point incident to the
highlighted geometry.
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Each point is displayed with a letter label. You can change the label from
the Select mode

.

Point is a modal command. You can continue making points until you
choose the select arrow or another drawing tool.

Adding Line Segments

To add line segments to your geometry follow these steps:
1. Click on the Line Segment icon
in the Draw toolbox or select
Line Segment from the Draw menu.
2. Position the cursor

in the drawing window.

3. Click the mouse to place each endpoint.
Each line segment is displayed with a letter label for each endpoint.

You can change the label from the Select mode

.

To abort a line segment in the middle of the drawing operation, hit the
"esc" key.
Line Segment is a modal command. You can continue making segments
until you choose the select arrow or another drawing tool.
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Drawing Lines

Lines are similar to line segments except they have infinite length.
1. Click the Infinite Line icon
Line from the Draw menu.
2. Position the line cursor

in the Draw toolbox or select Infinite

in the drawing window.

3. Click the cursor to anchor the line at the cursor position. The anchor
point will be displayed on the line.

4. Move the cursor in the drawing window to position the line and click
the cursor when you get the line in the desired orientation.
Lines are infinite and do not have points associated with them unless you
specifically place one on the line.
Line is a modal command. You can continue making lines until you
choose the select arrow or another drawing tool.
Active Axes The x and y axes have the properties of perpendicular infinite lines. When
the crosshairs are positioned over an axis, the incidence symbol (bow tie)
is displayed at the intersection and the axis is highlighted.
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the cursor is at the origin, both axes are highlighted
. Points and
End points of line segments can be placed directly on the axes without
using the Constrain / Incident tool when the bow tie is displayed.

Drawing Vectors

To add vectors to your geometry follow these steps:
1. Click the Vector icon
the Draw menu.
2. Position the cursor

in the Draw toolbox or select Vector from

in the drawing window.

3. Click the mouse to place each endpoint.
Each vector is displayed with a letter label for each endpoint.
Drawing vectors is similar to drawing line segments, but vectors are
constrained with coefficients of the form:

Vector is a modal command. You can continue making vectors until you
choose the select arrow or another drawing tool.
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Drawing Polygons

You can quickly create a multisided figure with these steps:
1. Click the Polygon icon
from the Draw menu.
2. Position the cursor

in the Draw toolbox or select Polygon

in the drawing window.

3. Move the cursor and click once to place each vertex.
·

As you create the sides of the polygon, each vertex is
automatically assigned a letter name. You can change the label in
Select

mode.

·

When you create the last side of the polygon by clicking on the
first vertex, the polygon will be filled with the default fill color,
style and transparency.

·

To change the appearance of the polygon (color or style), select
it, right click, and choose All Properties from the context
menu.

·

Polygon is a modal command. You can continue making polygons
until you choose the select arrow or another drawing tool.

Polygons can be filled with the color, style, and transparency level of your
choice. See the Edit /Preferences menu, Geometry tab to set the
default. To change the color / style /transparency level of selected
polygons, select the polygon(s), right-click, and select All Properties
from the Selection Context menu (or Edit / Properties from the menu
bar).
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Drawing Circles

To add a circle to your diagram, follow these steps:
1. Click the Circle icon
Draw menu.

in the Draw toolbox or select Circle from the

2. Move the cursor
in the drawing window to the position of the
center of the circle and click once.
3. Move the cursor to draw the circle in the desired size and click again.
Notice the circle is displayed with 2 points, the center and a point on the
perimeter.

Circle is a modal command. You can continue making circles until you
choose the select arrow or another drawing tool.
You can adjust the circle in Select

mode.

Circles can be filled with the color / transparency level of your choice. See
the Edit /Preferences menu, Geometry tab to set the default. To
change the color / transparency level of selected circles, select the circle
(s), right-click, and select All Properties from the selection context menu
(or Edit / Properties from the menu bar).
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Drawing Ellipses

To create an ellipse in your diagram, follow these steps:
1. Click the Ellipse icon
the Draw menu.

in the Draw toolbox or select Ellipse from

2. Move the cursor
in the drawing window to the position of one focal
point. Click to place the first focus point. Move the cursor and click
again to place the second focal point.
3. Then move the cursor to open the ellipse to the desired shape and
click the mouse a third time.

The ellipse will appear with three labeled points, the two foci and a point
on the ellipse.
The Ellipse tool is a modal command. You can continue making ellipses
until you choose the select arrow or another drawing tool.
Ellipses can be filled with the color / transparency level of your choice. See
the Edit /Preferences menu, Geometry tab, Conic properties group to
set the default. To change the color / transparency level of selected
ellipses, select the ellipse(s), right-click, and select All Properties from
the selection context menu (or Edit / Properties from the menu bar).
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Drawing Parabolas

To create a parabola in your diagram, follow these steps:
1. Click the Parabola icon
from the Draw menu.

in the Draw toolbox or select Parabola

2. Move the cursor
in the drawing window to the position of the
parabola's vertex. Click and drag the mouse along the major axis.
Release the mouse at the focus.
After sketching the general parabola, you can constrain it in the following
ways:
1. Click the parabola and select Implicit equation
Constrain toolbox and type or paste the formula.

from the

2. Constrain the vertex and focus points to some coordinate values.
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3. You can also adjust the parabola with the Translation, Rotation and
Dilation tools.

Drawing Hyperbolas

To create a hyperbola in your diagram, follow these steps:
1. Click the Hyperbola icon
in the Draw toolbox or select
Hyperbola from the Draw menu.
2. Move the cursor
in the drawing window to the position of one
focal point. Click to place the first focus. Move the cursor and click
again to place the second focal point.
3. Then move the cursor to open the hyperbola to the desired shape
and click the mouse a third time.
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The hyperbola will appear with three labeled points, the two foci and a
point on the hyperbola.
The Hyperbola tool is a modal command. You can continue making
hyperbolas until you choose the select arrow or another drawing tool.

Drawing Arcs

Arcs can be placed on any of the conics - circle, ellipse, parabola,
hyperbola - or any function. Points are automatically placed at the ends of
the arc.
Here are the steps:
1. First draw the conic or function which will be the basis for the arc.
2. Choose the Arc tool
and move the cursor over the section of the
existing curve where the arc will be defined. Click and drag the
cursor over the curve.
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Endpoints are automatically inserted on the arc.

Curvilinear Polygons
The Arc drawing tool lets you make curvilinear polygons for which you can
assign fill properties and find areas. There are some limitations, however.
Since you can't construct a point on two intersecting curves (except for
circles), you have to connect curves with line segments. If you want to
connect two arcs, you have to first connect them with a line and move it
to the intersection like this:
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To make a curvilinear polygon of the intersecting parabolas here are the
steps:
· Attach two lines.
· Make endpoints C and D -t point proportional along the curves.
· Make endpoints A and B t point proportional along the curves.
· Draw the two arcs - select Draw / Arc, from C to A and D to B.
· Select the sides and arcs of the polygon in order and click
Construct / Polygon.
· Set t=2 in the Variables toolbox and the lines will become the
intersection points.
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It's easier with circles because you can place points on their intersections:
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Drawing Regular Polygons

The N-gon tool lets you quickly draw any regular polygon. You can even
work on problems where the number of sides is n, or whatever variable
you choose.
Here are the steps:
1. Click the N-gon button

in the Draw toolbox.

2. Similar to drawing a circle, position the cursor to place the center of
the n-gon and click to the desired size. The n-gon at first appears to
be a pentagon.
3. In the data entry box, enter the number of sides you want or a
variable to represent the number of sides and press Enter.
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Drawing Curve Approximations

The Curve Approximation tool will insert a specified number of points
and edges evenly spaced on a selected section of a curve or conic. This is
a great tool for introducing problems using the Trapezoidal Method of
integration. (Take a look at our Gx book, Calculus Explorations .)
Here are the steps:
1. Click Draw / Curve Approximation

.

2. Select any function, circle, ellipse or parabola and drag the cursor
over the curve.
3. In the data entry box type the number of points you want on the arc.

Note: It is best to draw your curve independent of existing points on the
curve. Then connect other geometry to the approximation points. If you
start or finish the arc with points lying on the curve (e.g. point C in the
ellipse above) and later decide to delete the curve approximation,
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attached geometry may also get deleted.

Here is the area of a function using the Trapezoidal Method:

Adding Text to the Drawing

To add titles or other annotation to the drawing follow these steps:
1. From the Draw toolbox click the Text icon
the Draw menu.
2. Position the text cursor
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like your window of text located.
3. Click and drag to form your text box to the appropriate size.
4. Enter and format your text in the Edit Text dialog.
Enter mathematical statements using the Annotation / Expression tool.

Inserting and Editing Text
In the Edit Text dialog you can enter and format the text that will be
displayed in your defined text window.

The default text formatting for this dialog is set in Edit / Preferences /
Text & Pictures.
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Using Pictures in the Drawing

Liven up your examples with a picture or two, or use an image for
reference points in your drawing. Here's how:
1. Click the Picture icon
from the Draw menu.

in the Draw toolbox or select Picture

2. Click and drag the cursor to delimit the area where you want to place
the picture.
3. Find your image in the Select Image File dialog. Image formats
include: .bmp, .gif, .jpg, .pcx, .png, and .tif
4. After entering an image, you will be in Select

mode.

5.
Pictures are always inserted under your drawing objects, so you can add a
picture at any time.
In Select
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The inserted picture can be rotated and the transparency level can be set
in the Display Properties dialog box.
·

Right click on a highlighted picture and then select All Properties

·

Or select Properties from Edit menu.

Adding Expressions

You can type an algebraic expression in the drawing window and
Mechanical Expressions will solve it with whatever information it has
available. Here are the steps:
1. From the Draw toolbox click the Expression icon
Expression from the Draw menu.

or select

2. Move the expression cursor
to the position where you want it to
appear in the drawing window and click to display the data entry box.
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3. Enter the expression using numbers, variables, and output expression
names. Use the Symbols toolbox to help you enter mathematics.
Adding an expression to the diagram can help you work out relationships
in the geometry. Here is an example making use of the Expression tool
to see the relationship between similar triangles.

Sides a and b are perpendicular, and AC is perpendicular to BD. We
obtained the Output of lengths AD and BD using the Show Name button.
The expression to solve is the relationship of the two lengths: z0 / z1. The
system immediately evaluates the expression as => a/b.

Creating Functions

1. Click the Function icon
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from the Draw menu
2. Click the drop-down list button to select the function type that you
want to use in your drawing.

Cartesian Function
When you select Cartesian from the Function Type dialog, the next line
contains a general form of the function in terms of Y.

You can define a domain of the function by enter values for Start and End.
If you want to draw function with indefinite domain, leave these fields
blank.
You can define this function in these ways:
·

Modify the formula directly:
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Modify the function interactively using "handles". In the drawing
window, click the function to select it. Click and drag it and a circle
appears on the curve. This handle represents one of the variables in
the equation. You can click and drag this handle around the drawing.
Click and drag another place on the function and another moveable
handle appears if there is another variable in the equation.
This feature is a wonderful way to understand exactly how the
equation represents the function.
In the first example, a click of the curve gives you the b handle, the
y-intercept, and lets you drag the function up and down. Click and
drag another place on the curve and you get the a handle to change
the shape of the curve.
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Notice the Variable toolbox displays the changing values as you
move the handles.
·

Modify the function after it's drawn by double clicking the function tag
and changing it in the edit box.

·

Modify the domain of the function after it's drawn by double clicking
the curve.

The Generic Function f(X)
To use the generic form of a function, Y=f(X), select Cartesian from the
Function Type dialog, enter f(X) in the edit window and click OK:

Click the Functions tab of the Variables toolbox to see the values used
in the function.
You can define this function in these ways:
·

Modify the edit line at the bottom of the Functions tab. (Use your
keyboard arrow keys to move through the whole function.)

·

Modify the function interactively using "handles". In the drawing
window, click the function to select it. Click and drag it and a circle
appears on the curve. This handle represents one of the variables in
the equation. You can click and drag a handle around the drawing to
change the curve. Click and drag another place on the curve and
another moveable handle appears if there is another function
variable in the equation. In the general function in this example we
have 5 possible handles: f(a), f(b), f(k), f(u), and f(v).
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Polar Function
When you select Polar from the Function Type dialog, the next line
contains the general form of the function in terms of the radial
coordinate, r and the polar angle, T.

You can define this function in these ways:
·

Modify the formula and the curve domain directly:
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Modify the function interactively using "handles". In the drawing
window, click the function to select it. Click and drag it and a circle
appears on the curve. This handle represents one of the variables in
the equation. You can click and drag this handle around the drawing.
Click and drag another place on the function and another moveable
handle appears if there is another variable in the equation.
This feature is a wonderful way to understand exactly how the
equation represents the function.
In the example above, the second click gives you the a handle; click
and drag another place on the curve and you get the b handle to
change the shape of the curve.

Notice the Variable toolbox displays the changing values as you
move the handles.
·

Modify the function after it's drawn by double clicking the function
tag.

·

Modify the domain of the function after it's drawn by double clicking
the curve:
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Parametric Function
When you select Parametric from the Function Type dialog, the next
line contains the general form of the function in terms of X and Y and a
parameter, T.

You can define this function in these ways:
·

Modify the formula and its domain directly:
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Modify the function interactively using "handles". In the drawing
window, click the function to select it. Click and drag it and a circle
appears on the curve. This handle represents one of the variables in
the equation. You can click and drag this handle around the drawing.
Click and drag another place on the function and another moveable
handle appears if there is another variable in the equation.
This feature is a wonderful way to understand exactly how the
equation represents the function.
In the example above, X=T-asin(T), Y=b-cos(T), a click and drag
gives you the b handle, and lets you drag the function up and down.
Click and drag another place on the curve and you get the a handle
to change the shape of the curve.

Notice the Variable toolbox displays the changing values as you
move the handles.
·

Modify the function after it's drawn by double clicking the function
tag.

·

Modify the domain of the function after it's drawn by double clicking
the curve:
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Piecewise Function
A piecewise function or expression can be created using the Piecewise
symbol:

or the built-in function - piecewise({expression1, domain1},{expression2,
domain2}...,{last expression, otherwise}). The reserved word,
"otherwise" is an option available for the last condition.
Here we show how to enter the sequence of values, followed by
conditions:
·

Create a function.

·

Double click the equation
to edit.
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From the edit box click
the Piecewise icon in
the Symbols toolbox.
Four small gray boxes
will appear, including the
one containing the
original equation.

Fill in your piecewise
parameters - equations in
the left column and their
domain in the right
column. To expand the
function, click the
Piecewise icon again for
an additional row.
a+

Here's the finished piecewise function:

Piecewise Parametric Example
Any of the functions available in Mechanical Expressions can be piecewise,
including parametric functions. Take this square for example.
1. Click the Draw / Function tool
2. Select Parametric from the drop down Type window.
3. Enter the first value (side) for the square and the range for the
parameter values - hit enter. Don't worry about the shape of the
function, it's not defined yet.

© 2014 Saltire Software

Tools

77

4. Double-click the function and select the x value
5. Click the Piecewise icon
6. Enter the x values for each side of the square. When you run out of
gray boxes, click the Piecewise icon again to get another row.
7. Now do the same for the y value, select the T parameter and click the
Piecewise icon 3 times. Use the arrow keys on your keyboard or your
mouse to move to the next gray box.

Here is the function:

The Selection Arrow

When you are finished with the drawing functions, click the selection
arrow

to enable other functions or adjust your drawing.

With the arrow, you must first select elements of the drawing in order to
enter constraints and constructions and to output calculations.
Many of the tools require you to select multiple objects.
The Selection arrow is also available form the icon bar at the top of the
screen.
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Selecting Multiple Objects
Many of the Constrain, Construct, and Calculate tools require that you
select more than one object.
To select more than one object:
·

Click the selection arrow

on the tool bar.

·

Hold down the CTRL or SHIFT key as you click the objects you want to
select.

If you click the wrong object while holding down the CTRL key, click it
again and it will become unselected.
If all of the objects you wish to select fall within a rectangular region, you
can use the selection box:
·

Click on the selection arrow
toolbox.

on the tool bar or the Drawing

·

Draw a rectangle around all of the objects by clicking and dragging.

If you are using Mechanical Expressions on a Smartboard, turn on
Smartboard mode to make multiple selections without using the Ctrl or
Shift keys. In this mode selections accumulate. Clicking a blank space in
the drawing does not clear the selections. Clicking on an item a second
time unselects only that item.

Smartboard Mode
To turn on the Smartboard mode select Edit / Preferences / Selection;
in the Selection group and check (click) the Smartboard mode selection
box.
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When the box is checked, selections accumulate until you click a command.
Clicking a selected item a second time unselects that item, but any other
selected items stay selected. To clear all the selections, select Clear
Selection under the Edit menu or click all the selected objects again.

Adjusting the Drawing
Click the Select arrow
, either from the Drawing toolbox or the icon
bar, to move, rotate or delete selected object(s) in the drawing.
You can change a constraint value, annotation or label by double clicking
it, retyping the value or variable and then pressing the enter key.
The Scale, Zoom
shortcut:

and Move / Pan

functions have a mouse

·

The scroll wheel on your mouse can be used to Scale the drawing up
or down. Hold down the ctrl key while moving the wheel and the
operation becomes a Zoom.

·

Right-click and drag the mouse anywhere in the drawing window to
Move or Pan.

The Move geometry icon
you select

Constraints
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Using Drawing Constraints

After sketching the geometry of a problem, constrain it with
measurements, coordinates and implicit equations in real or symbolic
terms. The drawing responds automatically to the assigned input
constraints. Mechanical Expressions will automatically add any constraints
you leave out.
Since annotations may look identical to constraints, use the icon,
, to
Distinguish Constraints / Annotations. The icon is a toggle; to turn off
the marks, click it again.
Initially, all the constraints in the toolbox are inactive. You must first
select the parts for your drawing that will be constrained. Constraint
choices are listed below along with the drawing elements that must be
preselected. Be careful when selecting geometry objects, if extra things
are selected that are not related to the constraint (like other constraints)
the constraints will remain inactive. This can happen by mistake,
especially when using the selection box tool.
Constraint

Preselected Objects

Distance / Length

Two of any combination of points,
lines, line segments, vectors, or
polygon sides.

Radius

A circle

Perpendicular

Two of any lines, segments,
vectors, or polygon sides.

Angle

Two of any lines, segments,
vectors, or polygon sides.

Direction

A line, segment, vector, or polygon
side.
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Slope

A line, segment, vector, or polygon
side.

Coordinate

A point

Coefficients

A vector

Tangent

A circle or locus and a line,
segment, vector, or polygon side.

Incident

A point and a line, segment, vector,
polygon side, circle or locus.

Congruent

Two or three of any line segment,
vector, or polygon side.

Parallel

Two or three of any line segment,
vector, or polygon side.

Implicit Equation

A circle, line, segment, vector, or
polygon side.

Point Proportional
Along Curve

A point and a line, segment, vector,
polygon side, or locus

Occasionally you may try to add too many constraints to the geometry,
causing a conflict. The system will help you correct this problem in the
Resolve Constraint Conflict dialog.

Changing a Constraint
To change a constraint, double click it with the selection arrow,
the value or variable and press the enter key.
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Distinguishing Constraints from Annotations
Your drawing is defined by Constraints on geometry elements.
Annotations are like labels and have no influence on the geometry
measurements. The original default settings (Preferences / Math) fix
Constraint lines and text in blue and Annotation lines and text in black.
To further distinguish these use the Distinguish Constraints /
Annotations

toggle button on the main icon bar.

When active, the button is highlighted all constraints and a

, and a

is placed next to

is placed next to all annotations.

As with all toggles, you can turn these marks off with another click of the
button.

System Added Constraints
In Mechanical Expressions, you do not need to fully constrain your model.
Any parameters you have left unconstrained are filled in by the geometry
engine.
For example, the following drawing is constrained only modulo a rigid
transformation (typical for many geometry problems).
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So if you ask for the coordinates of any of the points, they will be given in
terms of system added variables:

Clearly the system has added variables for the location of point A, and for
the direction of line AC.
To display these variables, check the default setting, Show System
Variables, found in the Edit / Preferences menu selection on the Math
page (left panel) under Output.
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When the box is checked, you will see the system variables when you
select the output:
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Constraint Conflicts
If you enter a constraint for some geometry which is already constrained
by another constrained object you will see a message like the one below.

In this case, the Coordinate constraint was already determined by the
other two sides and an angle constraint on the triangle. There are three
ways of dealing with this problem:
1. Hit the Cancel button to leave the drawing as it was without the new
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constraint.
2. Click the first button, "Calculate the coordinates from other
constraints" (the default choice). This is similar to the first choice, it
eliminates the new constraint, but also calculates the selected
geometry’s value. In this case, the coordinates of point C would be
calculated and displayed.
3. If you choose "Relax other constraints so the coordinate is
independent", this will keep the new constraint you just entered and
allow you to eliminate one of the red highlighted constraints (figure 1).
When you select one of these constraints (in figure 2 below we clicked
on q), the highlight changes to gray. After you click Ok, the selected
constraint, the angle q in this case, is calculated and displayed (figure
3).

Figure 1

Figure 2
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Figure 3

Distance / Length Constraint

The Distance / Length constraint lets you specify the following
dimensions:
·

Length of a line segment, vector, or polygon side

·

Distance between two points or a point and any one of the line types
listed above.

·

To enter a constraint:
1. Select

the appropriate drawing object(s). When you make your

selection, the Distance / Length icon will light up

.

2. Click the icon, enter the constraint value, either real or symbolic,
and press enter. You can press enter without typing a value to
accept the system's default value.
You can click the constraint and drag it to adjust its placement on the
drawing.
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Radius Constraint

To specify the radius of a circle:
1. From select mode
well as the icon

,

click the circle. The circle will be highlighted as

.

2. Click the Radius icon, enter the constraint value, either real or
symbolic, and press enter. You can press enter without typing a value
to let the system insert a variable name.
You can click the constraint and drag it to adjust its placement on the
drawing.

Perpendicular Constraint

Any two of lines, segments, vectors or polygon sides can be constrained to
be perpendicular with these steps:
1. Select

two from the line types listed above.

2. Click the Perpendicular icon

.

The lines are redrawn and the perpendicular constraint is attached.

© 2014 Saltire Software

Tools

89

Angle Constraint

Any two of lines, segments, vectors or polygon sides can be constrained
with an angle value or variable name with these steps:
1. Select

two from the line types listed above.

2. Click the Angle icon

.

3. Enter the constraint, real or symbolic. If you enter a real value, the
lines will be adjusted to reflect the constraint.
Which Side to Constrain?
Sometimes when identifying angles, the constraint falls on the wrong one.
In the example below, we wanted BDC, not BDA. Just click the cursor
over the constraint arrow and drag it to the other side, then release the
mouse button - done!

Note: The angular units are displayed in the lower right of the screen.
Change the default Angle Mode in the Edit / Preferences / Math
Properties menu, Math settings group.
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Direction Constraint

Constrain any of the line types; line, line segment, vector, or polygon side,
to a direction measured from the horizontal.
1. Select

one of the line types listed above.

2. Click the Direction icon

.

3. Enter the constraint, real or symbolic. If you enter a real value, the
line will be adjusted to reflect the constraint.
Note: The angular units are displayed in the lower right of the screen.
Change the default (Degrees or Radians) in the Edit / Preferences
menu.

Slope Constraint

Specify a slope for any of the line types; line, line segment, vector, or
polygon side.
1. Select

one of the line types listed above.

2. Click the Slope icon

.

3. Enter the constraint, real or symbolic. If you enter a real value, the
line will be adjusted to reflect the constraint.
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Coordinate Constraint

You can give coordinates to any point in your drawing:
1. Select

a point.

2. Click the Coordinate icon

.

3. Enter the constraint, real or symbolic. If you enter a real value, the
line will be adjusted to reflect the constraint, even if the coordinate
axes are not displayed.
To change the coordinates shown, double click and type over the
highlighted value in the data entry box.

Constraining Vector Coeffecients

You can specify coefficients for a vector with the following steps:
1. Select

a vector.

2. Click the coefficients icon

.

3. Enter the coefficients separated by a comma.
Note: Don't forget the parentheses or an error message appears.
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Tangent Constraint

Any of the line types; line, line segment, vector, or polygon side can be
made tangent to a circle or locus with these steps:
1. Select

a line of the types listed above and the circle or locus.

2. Click the Tangent icon
from the Constrain tool box or select
Tangent from the Constrain menu.
The line and curve immediately become tangent.

Incident Constraint

Constrain a point to be incident to any other geometry; line, segment,
vector, polygon side, circle or locus with these steps:
1. Select

the point and the other geometry listed above.

2. Click the Incident icon
from the Constrain toolbox, or select
Incident from the Constrain menu.
The point is moved to meet the line or curve, or the extension of the line.
Below is an example of the latter, point D is moved to lie on the extension
of line segment AB.
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If you select the point or the line, incidence is indicated by a bowtie
around the point:

Congruent Constraint

Constrain two or three of any of these geometry types: line segments,
vectors, or polygon sides, to be congruent with these steps:
1. Select

two line segments.

2. Click the Congruent icon
from the Constrain toolbox, or select
Congruent from the Constrain menu.
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You will see matching congruency lines on the selected segments and a
length will be adjusted.

Parallel Constraint

Any two or three of the linear geometry types can be made parallel: line,
segment, vector, or polygon side.
1. Select

two or three from the types listed above.

2. Click the Parallel icon
from the Constrain toolbox, or select
Parallel from the Constrain menu.
The geometry will be adjusted and matching symbols

appear on the selected lines.
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Implicit Equation Constraint

You can use symbolic variables to constrain geometry with an implicit
equation. Lines, line segments, polygon sides, vectors and circles and
conics can all be constrained with implicit equations.
1. Select

the geometry.

2. Click the Implicit Equation icon
from the Constrain toolbox, or
select Implicit Equation from the Constrain menu.
An input window will open next to the geometry you selected. Highlighted
in the window is a generic equation for the selected object; for a line, an
equation like - XA1+YB1+C1 = 0 might appear. You can edit the equation
with different variable names or coefficients as you like. You will find these
variables added to the variable list in the Variables toolbox.

Point Proportional Along a Curve Constraint

A point proportion t along a curve is defined variously for different types of
curves as follows:
·

For a Line segment AB, it defines the point (1-t)•A + t•B

·

For a Circle it defines the point on the circle which subtends angle t at
the center.

·

For a Locus or envelope, it defines the point at parameter value t.

·

For general Cartesian functions, it defines the x value of the point on
the function.
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·

For Polar functions, it defines the point on the function which
subtends angle t.

·

For general Parametric functions, it defines the point at parameter
value t.

·

For an Ellipse of the form X2/a2 + Y2/b2 =1 it defines the point (a cos(
t), b sin(t)).

·

For a Parabola of the form Y=X2/4a it defines the point (2at, at2)

·

For a Hyperbola of the form X2/a2 - Y2/b2 =1 it defines the point (a/
cos(t), (b sin(t))/cos(t)).
1. Select

a point and one of the curves mentioned above.

2. Click the Point Proportional icon
from the Constrain
toolbox, or select Point Proportional from the Constrain menu.
3. Enter the parameter or quantity (symbolic or real) in the data entry
box.
For example, in the following diagram, D is defined proportion t along AB,
and E is defined proportion t along BC. The curve is the locus of F as t
varies between 0 and 1.
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In the following example, the curve is the locus of the point (x,x2).
Tangents are created at points with parameter values x0 and x1 on this
curve.
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Where is Point proportional along curve for conics?
The best way to understand the location of Point proportional along
curve command for conics is to see how we construct it geometrically for
each conic:
Ellipse
The ellipse with foci A and B is inscribed in circle, center M. Draw the
radius MN at angle t to the major axis and drop the segment NO
perpendicular to the major axis of the ellipse. When the intersection of
NO with the ellipse (point C) is constrained to be t proportional along the
ellipse, it's coordinates will be (a cos(t), b sin(t)).
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Parabola
C lies on the parabola and BC is perpendicular to the axis AB of the
parabola. Point D is located proportion t along the segment. Point F is the
intersection of the perpendicular to BC through D with the parabola. It
has the coordinates (2at, at2) when it is constrained to parametric
location t on this parabola.

Hyperbola
CD is the perpendicular projection of C onto the axis of the hyperbola, GF
is the circle centered at the center of the hyperbola which goes through
the intersections of the hyperbola with its axis. H is the point of contact of
this circle with the tangent from D. We can see that the angle DGH is the
same as the parameter value. When point C is constrained to be at
parametric location t along the curve, its coordinates are (a/cos(t), b sin(t
)/cos(t)) on this hyperbola.
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Constructions

Creating Constructions

After sketching and constraining your drawing there are a whole set of
constructions that can be applied to the geometry. First you must select
the geometry elements which pertain to the construction. When you select
the geometry the appropriate constructions will be highlighted.
The following table lists the Constructions, their icons, and which
elements must be preselected to activate the constructions. Be careful
when selecting geometry objects, if extra things are selected that are not
related to the construction, the construction icons will remain inactive.
This can happen by mistake, especially when using the selection box tool.
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Construction

Preselected Objects

Midpoint

A line segment, vector, or polygon side.

Intersection

Two of: a line, segment, vector, polygon
side or conic. Conics are limited to
intersecting only with lines, segments and
vectors.

Perpendicular
Bisector

A line segment, vector, or polygon side.

Angle Bisector

Two of: a line, segment, vector, or
polygon side.

Parallel

A point and one of: a line, segment,
vector, or polygon side.

Perpendicular

A point and one of: a line, segment,
vector, or polygon side.

Tangent

A circle or curve, and optionally, a point
on the curve

Polygon

Three or more connected line segments or
points (vertices) to form a polygon

Reflection

One or more objects

Translation

One or more objects

Rotation

One or more objects

Dilation

One or more objects

Locus

A point or line that will vary with a
parameter
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Trace

One or more objects that will vary with a
parameter

Area Under Arc

An arc of a Cartesian function

Midpoints of Line Segments

You can construct a midpoint on any line segment, vector, polygon side, or
between two points by:
1. Select

two from the geometry types listed above.

2. Click the Midpoint tool
menu.

, or select Midpoint from the Construct

A point will appear in the middle of the selected line.

Intersections

You can construct a point of intersection between any of the line types in
your geometry; line, segment, vector, polygon side or circle. You can also
construct intersections of circles. Conics are limited to intersections only
with lines, segments or vectors.
1. Select

two from the line types listed above.

2. Click the Intersection tool
Construct menu.

or select Intersection from the

© 2014 Saltire Software

Tools

103

A new point and label will appear at the intersection. If the lines are
segments that do not intersect, a point will be created at the extension of
the lines as with line segments AB and CD below.

If the geometry will never intersect, the selected objects are moved to
form the intersection. In the example below, the infinite line and circle
become tangent at the newly created point, H.

Perpendicular Bisector

You can construct a perpendicular bisector on any line, segment, vector,
or polygon side with these steps:
1. Select

any of the line types listed above.

2. Click the Perpendicular Bisector tool
Bisector from the Construct menu.

or select Perpendicular

An infinite line will appear at right angles to the selected line.
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Angle Bisector

You can bisect the angle between any combination of line types; line,
segment, vector, or polygon side with these steps:
1. Select

two of any of the line types listed above.

2. Click the Angle Bisector tool
Construct menu.

or select Angle Bisector from the

An infinite line will appear between the two selected lines. You can use
the Calculate / Angle tool to get the value of the bisected angle.

Parallel Constructions

You can construct a line, through a point, and parallel to another line,
segment, polygon side or vector with these steps:
1. Select

a point and a line of one of the types listed above.

2. Click the Parallel tool
menu.

or select Parallel from the Construct

A line is constructed which is parallel to the selected line and passes
through the selected point.
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Perpendicular Constructions

You can construct a line, through a point, which is perpendicular to
another line, segment, polygon side or vector with these steps:
1. Select

a point and a line of one of the types listed above.

2. Click the Perpendicular tool
Construct menu.

or select Perpendicular from the

A line is constructed which is perpendicular to the selected line and passes
through the selected point.

Tangents

You can construct a line that is tangent to a circle or curve with these
steps:
1. Select
the circle or curve. You can also select a point on the curve
so that the tangent goes through the point on the curve.
2. Click the Tangent tool
menu.

or select Tangent from the Construct

A line tangent to the selected curve will appear at the point where you
selected the circle or curve, or at the selected point.
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Polygon Construction

If you created a polygon with the line segment tool, or your polygon was
not shaded for some reason, (e.g. the drawing of the sides was
interrupted or out of order) you can make joined line segments into a
polygon that can be selected with a single click using this construction.
1. Select

the line segments that make up the polygon.

2. Click the Polygon tool
in the Construct toolbox, or select
Polygon from the Construct menu.
The polygon will be filled and you can now select the entire polygon with a
single click.

Reflection

You can reflect any subset of your diagram about a line with these steps:
1. Select

one or more geometry objects to reflect.

2. Click the Reflection tool
in the Construct toolbox, or select
Reflection from the Construct menu.
3. Either click the cursor to place the reflection line on the screen, adjust
the angle and click again, or select an existing line as the reflection
line.
A copy of your selected geometry will appear on the other side of the
reflection line.
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Notice all points on the reflected geometry are written as "prime", i.e. A
becomes A'. If you reflect the geometry again, A' becomes A".

Translation

You can translate any subset of your diagram with a translation vector.
Here are the steps:
1. Select

the geometry to be translated.

2. Click the Translation tool
in the Construct toolbox, or select
Translation from the Construct menu.
3. Click the cursor to draw the end point of your translation vector and
move the cursor to establish the length and angle of the translation.
Click again to finish the vector.
The translated geometry appears. You can adjust the position of the
translation by clicking and dragging the tip of the vector.
Notice all points on the translated geometry are written as "prime", i.e. A
becomes A'. If you translate this geometry again, A' becomes A".

Rotation

You can rotate any subset of your diagram about a point. Here are the
steps:
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1. Select

the geometry to be rotated.

2. Click the Rotation tool
in the Construct toolbox, or select
Rotation from the Construct menu.
3. Click the screen to place your rotation point.
4. In the data entry box presented, enter the angle of rotation.
The rotation of the selected geometry appears.
Notice all points on the rotated geometry are written as "prime", i.e. A
becomes A'. If you rotate this geometry again, A' becomes A".

Dilation

You can dilate any subset of your diagram from a point. Here are the
steps:
1. Select

the geometry to be dilated.

2. Click the Dilation tool
in the Construct toolbox, or select
Dilation from the Construct menu.
3. Click the cursor on your dilation point.
4. In the data entry box presented, enter the dilation factor.
The dilated geometry appears.
Notice all points on the dilated geometry are written as "prime", i.e. A
becomes A'. If you dilate this geometry again, A' becomes A".
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Locus of Points / Envelope

You can construct a locus of points or envelope from a selected point or
line, by defining a range for some constraint in the drawing. Just follow
these easy steps:
1. Select
the point on the drawing that will form the locus (point B in
the example below); select a line, line segment, or vector to form an
envelope.
2. When you click the Locus icon

, the Edit Locus dialog pops up.

3. You need a parameter to drive the motion to create the locus. Click
the arrow key to the right of the Parametric Variable window to
select from a list of all variables in the drawing. (If you entered the
needed constraint in real terms, Cancel the trace and change the
constraint to a variable by double-clicking it in the drawing window.)

4. Simply fill in the values for the appropriate variable and click the Ok
button.
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Note: The locus only works if the figure's position is fixed i.e. a point in
a triangle will not work as a locus unless the location of the other two
points are fixed with coordinate constraints.
To adjust the range of the locus, double-click the locus to edit the dialog.
The following example shows an envelope of the line DE. We use the Point
proportional along curve constraint and the parameter t to position the
points D and E (D is (1-t) along line AC and E is t along line AB). In the
Edit Locus dialog, we create the envelope from parameter t as it ranges
from 0 to 1.
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You can replay the creation of the envelope with the Animation tools.
Select variable t and click the Play button.

Trace

You can Trace the movement of one or a group of drawing objects. You
can create string art drawings and see how an envelope curve is formed.
Here are the steps:
1. Select

the drawing objects to be traced.

2. Click the Trace tool

and the Edit Trace dialog pops up.

3. You need a parameter to drive the motion of the trace. Click the
arrow key to the right of the Parametric Variable window to select
from a list of all variables in the drawing. (If you entered the needed
constraint in real terms, Cancel the trace and change your constraint
to a variable by double-clicking it in the drawing window.)

4. Simply fill in the values for the appropriate variable and click the OK
button.
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To adjust the range or number of traces, double-click one of the traces to
edit the dialog.

Area Under the Arc
The Area Under Arc function is found only in the Construct menu at the
top of the main window. Here are the steps:
1. Select an arc drawn over a function.
2. Select Construct / Area Under Arc.
A filled area is created between the arc and the X axis. The necessary
lines and points containing the area are automatically added.
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Drag the handles of the original function and the area under the curve
changes accordingly.

This is a great way to illustrate the definite integral.
Note: this only works for arcs drawn on functions. For arcs drawn on
conics, create the sides with the Draw / Line Segment, select all sides
and use the Construct / Polygon tool. See also: instructions for
creating curvilinear polygons.
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Integral Calculus
The Area Under Arc function is a great way to show problems with the
definite integral.
Here are the steps for making the integral of the generic function f(x) over
the interval a to b:
1. Select the Draw / Function tool and enter f(x) in the Y= data entry
box. Click OK.
2. Use the Draw / Arc tool to trace over some portion of the function.
3. Select the new arc - be careful not to select the whole function. Just
the section of arc should be highlighted.
4. Choose Area Under Arc from the Construct menu. The area
between the arc and the X axis will be filled.
5. For each endpoint of the arc, use the Constrain / Point
proportional along curve tool to define the limits of the region, e.g.
select a and b from the Symbols toolbox.
6. Select the area under the arc and click Calculate / Symbolic /
Area.
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Annotations

Applying Annotations
Annotations allow you to add constraint information to your drawing which
isn't needed for its construction. These might be constraints that cause
the geometry to be over constrained, but you might want to give the
viewer some additional information. This feature can be very helpful for
making up texts or worksheets.
Annotate tools are similar to Text in that they have no influence on the
geometry engine, even though they are placed exactly like the Constrain
tools.
Since annotations may look identical to constraints, use the icon from icon
bar
at the top of the window to Distinguish Constraints /
Annotations. The icon is a toggle; to turn off the marks, click it again.
The Symbols and Annotation Symbols toolboxes are both available to
the Annotate tools.
Here are the Annotate tools and the object(s) to preselect:
Annotation

Preselected Object(s)

Distance / Length A line segment, vector, or polygon side, or
a point and one of these line types
(perpendicular distance), or two points.
Radius

Circle

Perpendicular

Two of any line, segment, vector, or
polygon side.

Angle

Two of any line, segment, vector, or
polygon side.
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Direction

A line, segment, vector, or polygon side.

Slope

A line, segment, vector, or polygon side.

Coordinates

Point

Coefficients

Vector

Congruent

A line, segment, vector, or polygon side.

Congruent Angle

Two of any lines, segments, vectors, or
polygon sides

Parallel

A line, segment, vector, or polygon side.

Expression

[none]

Distance / Length Annotation

Length annotations may be applied to any line, segment, polygon side or
vector. Distance annotations are available between two points, or the
perpendicular distance between a point and a line, segment, polygon side,
or vector. Use these steps:
1. Select
the line segment, or point and line, or pair of points as
described above. When you make your selection, the drawing
objects will be highlighted and the Distance / Length icon will light
up

.

2. Click the icon
3. Enter the distance information. There are no format restrictions. You
can use Symbols and Annotation Symbols in the entry. Press enter
when you're done.
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You can click the annotation and drag it to adjust its placement in the
drawing.

Radius Annotation

To annotate a circle's radius use these steps:
1. Select
the circle. The Annotate / Radius icon
and the circle will be highlighted.

will light up

2. Click the icon
3. Enter the radius information. There are no format restrictions. You
can use Symbols and Annotation Symbols in the entry. Press enter
when you're done.
You can click the annotation and drag it to adjust its placement in the
drawing.

Perpendicular Annotation

The perpendicular annotation inserts the perpendicular mark between any
two of these line types: line, segment, polygon side or vector. Use these
steps:
1. Select

two of any line, segment, vector, or polygon side. The

Annotate / Perpendicular icon
highlighted.

© 2014 Saltire Software

will light up when both lines are

118

Mechanical Expressions Manual

2. Click the icon.

Note: Placing this annotation between two lines does not change the
relative position of the lines or prevent the lines from changing their
relative position as it does with the Constrain tool of the same name.

This annotation is very useful if you are displaying a 3-d object. In this
example we imported the Triangular Prism from the Solids folder in the
Figure Gallery.

Angle Annotation

To annotate an angle use these steps:
1. Select

two of any line, segment, vector, or polygon side. The
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will light up and the lines will be

2. Click the icon
3. Enter the angle information. There are no format restrictions. You
can use Symbols and Annotation Symbols in the entry. Press enter
when you're done.
Which Side to Annotate?
Sometimes when identifying angles, the annotation falls on the wrong one.
In the example below, we wanted BDC, not BDA. Just click the cursor
over the annotation arrow and drag it to the other side, then release the
mouse button - done!

Direction Annotation

To annotate a line's direction use these steps:
1. Select

a line, segment, vector, or polygon side. The Annotate /

Direction icon

will light up and the line will be highlighted.

2. Click the icon
3. Enter the direction information. There are no format restrictions.
You can use Symbols and Annotation Symbols in the entry. Press
enter when you're done.
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You can click the annotation and drag it to adjust its placement in the
drawing.

Slope Annotation

To annotate a line's slope use these steps:
1. Select

a line, segment, vector, or polygon side. The Annotate /

Slope icon

will light up and the line will be highlighted.

2. Click the icon
3. Enter the slope information. There are no format restrictions. You
can use Symbols and Annotation Symbols in the entry. Press enter
when you're done.
You can click the annotation and drag it to adjust its placement in the
drawing.

Coordinate Annotation

To annotate an point's coordinates use these steps:
1. Select
point. The Annotate / Coordinate icon
and the point will be highlighted.

will light up

2. Click the icon
3. Enter the coordinate information. There are no format restrictions.
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You can use Symbols and Annotation Symbols in the entry. Press
enter when you're done.
You can click the annotation and drag it to adjust its placement in the
drawing.

Coefficients Annotation

To annotate a vector's coefficients use these steps:
1. Select
vector. The Annotate / Coefficients icon
up and the vector will be highlighted.

will light

2. Click the icon
3. Enter the vector's coefficients. There are no format restrictions. You
can use Symbols and Annotation Symbols in the entry. Press enter
when you're done.

You can click the annotation and drag it to adjust its placement in the
drawing.
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Congruent Annotation

Place a congruent mark on any of the linear drawing elements: lines,
segments, vectors, or polygon sides. Use these steps:
1. Select

any line, segment, vector, or polygon side. The

Annotate / Congruent icon
highlighted.

will light up when both lines are

2. Click the icon.

Note: Placing this annotation on lines does not change the relative lengths
of the lines or keep them the same length as it does with the Constrain
tool of the same name.

Congruent Angle Annotation

Place a congruent mark between pairs of linear drawing elements: lines,
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segments, vectors, or polygon sides. Use these steps:
1. Select

two lines, segments, vectors, or polygon sides. The

Annotate / Congruent Angle icon
are highlighted.

will light up when both lines

2. Click the icon.

You can change the arc count with these steps:
1. Select the annotation.
2. Right click to invoke the selection Context menu.
3. Select Tic/Arc Count from the menu and click the desired
number.

© 2014 Saltire Software

124

Mechanical Expressions Manual

Parallel Annotation

Place a parallel mark on any of the linear drawing elements: lines,
segments, vectors, or polygon sides. Use these steps:
1. Select

_ any line, segment, vector, or polygon side. The

Annotate / Perpendicular icon
highlighted.

will light up when both lines are

2. Click the icon.
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Note: Placing this annotation on lines does not change the relative
position of the lines or prevent the lines from changing their relative
position as it does with the Constrain tool of the same name.

Expression Annotation

The Annotate / Expression command is useful for placing a line of
mathematics anywhere in your drawing.
1. Click the icon

.

2. Move the cursor to the position where you want to place the
expression and click.
3. Enter the expression. There are no format restrictions. You can use
Symbols and Annotation Symbols in the entry. Press enter when
you're done.
You can click the annotation box and drag it to adjust its placement in the
drawing.
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Calculations

Calculating the Output

Mechanical Expressions will make calculations in the geometry based on
any constraints or constructions you have specified, or just from the
sketch. Calculations can be output in Real or Symbolic terms by choosing
the appropriate tab.
If you haven't supplied all of the necessary input constraints, the system
inserts any missing variables automatically or, for real calculations, bases
the value on the sketch.
Some calculations may take longer than you expected. If the calculation
isn't immediate, you can stop it and restart it with these buttons on the
tool bar.
Stop calculations
Start calculations.
You may want to reconsider the problem, add constraints, or just let it
continue with the calculation.
The Stop calculations and Start calculations can also be found under
Calculate (Output) menu and under the general context menu.
The table below lists all the available calculations and geometry elements
which must be preselected. Be careful when selecting geometry objects, if
extra things are selected that are not related to the calculation (like other
calculations) the calculations will remain inactive. This can happen by
mistake, especially when using the selection rectangle.
Calculation

Preselected Object(s)
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Distance /
Length

A line segment, vector, or polygon side,
or a point and one of these line types
(perpendicular distance), or two points.

Radius

Circle

Angle

Two of any line, segment, vector, or
polygon side.

Direction

A line, segment, vector, or polygon
side.

Slope

A line, segment, vector, or polygon
side.

Coordinates

Point

Area

Circle or polygon

Perimeter

Circle or polygon

Coefficients

Vector

Parametric
Equation

A line, segment, vector, polygon side,
circle, or a constructed locus.

Implicit Equation A line, segment, vector, polygon side,
circle, or a constructed locus.

Distance / Length Calculation

Length calculations may be obtained for any line segment, polygon side or
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vector. Distance calculations are available between two points, or the
perpendicular distance between a point and a line, segment, polygon side,
or vector. Use these steps:
1. Select
the line segment, or point and line, or pair of points as
described above.
2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Distance / Length tool in the Calculate toolbox or select
Distance / Length from the Calculate menu.
Mechanical Expressions displays the length, using any relevant parameters
you may have specified.

Radius Calculation

Mechanical Expressions will calculate the radius of any circle. Use these
steps to find the radius:
1. Select

a circle.

2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Radius tool in the Calculate toolbox or select Radius from
the Calculate menu.
The equation with real or symbolic terms appears in the diagram.
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Angle Calculation

Mechanical Expressions will calculate any angle between lines in the
geometry. Use these steps to find the angle:
1. Select

two line types - any line, segment, vector, or polygon side.

2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Angle tool in the Calculate toolbox or select Angle from
the Calculate menu.
The equation with real or symbolic terms appears in the diagram.
You can obtain the angle's supplement by dragging the angle symbol.

Supplementary Angles
If it's unclear whether a calculation is requested for the angle or its
supplement, you can drag the angle symbol to the correct position.
Here are some examples of playing around with supplementary angles
(inputs, outputs and angle annotations all have this feature):
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Direction Calculation

Mechanical Expressions will calculate the direction of lines, segments,
polygon sides, or vectors with these steps:
1. Select

a line type.

2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Direction tool in the Calculate toolbox or select Direction
from the Calculate menu.
The direction measurement appears in real or symbolic terms.

Slope Calculation

Mechanical Expressions will calculate the slope of lines, segments, polygon
sides, or vectors with these steps:
1. Select

a line type.

2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Slope tool in the Calculate toolbox or select Slope from the
Calculate menu.
The equation for the slope with real or symbolic terms appears in the
diagram.
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Coordinates Calculation

You can calculate the coordinates of any point in your diagram with these
steps:
1. Select

a point.

2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Coordinates tool in the Calculate toolbox or select
Coordinates from the Calculate menu.
The real or symbolic coordinates appear by the point.

Area Calculation

You can obtain the area of any polygon or circle in your diagram.
Note: If your polygon is not filled it is just a group of line segments. To
convert them to a polygon, use the Polygon Construction tool, then
proceed with these steps:
1. Select

a circle or polygon.

2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Area tool in the Calculate toolbox or select Area from the
Calculate menu.
The area is displayed in real or symbolic terms.
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Coefficients Calculation

Use this tool to calculate the coefficients of a vector in the diagram with
these steps:
1. Select

a vector.

2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Coefficients tool in the Calculate toolbox or select
Coefficients from the Calculate menu.
The real or symbolic coefficients appear by the vector.

Perimeter Calculation

You can obtain the perimeter of any polygon or circle in your diagram.
Note: If your polygon is not filled it is just a group of line segments. To
convert them to a polygon, use the Polygon Construction tool, then
proceed with these steps:
1. Select

a circle or polygon.

2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Perimeter tool in the Calculate toolbox or select Perimeter
from the Calculate menu.
The perimeter is displayed in real or symbolic terms.

© 2014 Saltire Software

134

Mechanical Expressions Manual

Calculating Parametric Equations

Computes parametric equations for a locus or envelope, based on the
parameter defining the curve.
You can also calculate parametric equations for a circle or line.
Use these steps:
1. Select

any geometry object described above.

2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Parametric Equation tool in the Calculate toolbox or
select Parametric Equation from the Calculate menu.
The real or symbolic equations for x and y appear by the geometry.

Calculating Implicit Equation

Calculates the implicit equation for the selected circle or a line.
Mechanical Expressions will also attempt to calculate the equation of a
locus or envelope curve.
1. Select

any geometry object described above.
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2. Click the tab to switch from Real to Symbolic output or vice versa.
3. Click the Implicit Equation tool in the Calculate toolbox or select
Implicit Equation from the Calculate menu.
The real or symbolic equation appears by the geometry.

Mechanics Inputs

Applying Mechanics Inputs

There are a number of Mechanics inputs you can apply to your drawing.
Initially, all the inputs in the toolbox are inactive. You must first select the
element in your model connected to the desired input. The following table
lists all the Mechanics inputs and the elements you must preselect.
Mechanics Input
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Preselected Object

Applied Force

A point or a vector

Applied Torque

A line segment

Mass

A point

Moment

A line segment

Spring - Damper Actuator

A line segment or two
points

Velocity /
Acceleration

A Coordinate, Distance /
Length, or Angle
Constraint
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Applied Force
Forces are applied to points or vectors.
·

select a point or vector

·

click Mechanics Input / Applied Force

·

enter the x,y value of the force for a point, or the force value for the
vector. The direction of the force is taken from the vector.

Applied Torque
Input torque is applied to line segments.
·

select a line

·

click Mechanics Input / Applied Torque

·

enter the value

The example below shows a pump model with an input torque T.
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Mass
Masses are applied to points.
·

select a point

·

click Mechanics Input / Mass

·

enter the value

Moment
A moment of inertia is applied to line segments.
·

select a line

·

click the Moment icon from the Mechanics Input toolbox

·

enter the value
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In the model below we give member BC a Moment of I.

Spring - Damper - Actuator
Springs, dampers and actuators are attached to line segments.
·

select a line or two points

·

click Mechanics Input / Spring - Damper - Actuator

The dialog box appears.
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·

check Enabled checkbox for the element you want to add

·

fill in the values for the element you want to add.

·

check that the Enabled checkbox for the elements you don't want to
include is unchecked

The example below is a model of a spring with spring constant k, attached
to a pendulum.
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Velocity - Acceleration
Velocities and accelerations are conveyed through constraints.
·

select a point's Coordinates, a Distance / Length constraint, or
an Angle constraint

·

click the Velocity - Acceleration icon in the Mechanics Input
toolbox

·

enter the velocity

The acceleration is initially set to 0. To change the acceleration

·

double-click the acceleration

and enter the new value

In the example below we assigned an angular velocity to the pendulum.

Mechanics Output
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Viewing Mechanics Outputs

Based on your input specifications, Mx will perform a full range of force
analyses including static, inverse dynamic, kinematic and tolerance
analysis. You can obtain numeric values by selecting the Real tab, or
symbolic expressions by selecting the Symbolic tab. Initially, all the
outputs in the toolbox are inactive. You must first select the element in
your model which carries desired output. The following table lists all the
Mechanics outputs and the elements you must preselect.
Icon

Mechanics
Output

Preselected Object(s)

Reaction Force

A point, line segment or polygon side

Pin Reaction

A line segment and one of its endpoints

Velocity /
Acceleration

A line segment or polygon side

Resultant
Acceleration

A Coordinate or Distance / Length
Constraint

Differential
Equations

A Resultant Acceleration

Reaction Force
Forces are carried by constraints.
·

select a point's Coordinates, a Distance / Length constraint, or
an Angle constraint

·

select the Reaction Force icon in the Mechanics Output toolbox
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The model below has an applied force at the apex. We measure the
reaction force in members AB and BC and the force holding the whole
thing together (z2)

Pin Reaction
To see the reaction force on a pin, select the pin and its line segment - the
member it attaches. In the example below, we calculate the reaction
force on pin A viewed as part of the member AB:
·

Holding down the shift key, select point A and line AB

·

Select Mechanics Output / Pin Reaction
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Velocity - Acceleration
Measure the velocity and acceleration of points and lines.
·

select a point or line or the measurement of a distance or angle to
get the relative velocity

·

click the Velocity - Acceleration icon in the Mechanics Output
toolbox

The pendulum in the example below has an angular input velocity,
The resultant velocity and acceleration of point B is displayed.
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Resulltant Acceleration
Output accelerations are taken from constraints which are considered free
to accelerate.
·

select a Distance / Length constraint, or an Angle constraint

·

select the Resultant Acceleration icon in the Mechanics Output
toolbox

In the example below we calculate the acceleration of the pendulum in
angle .

Differential Equations
For Dynamics models, you can get the equations of motion for any
Resultant Accelerations. The equations of motion are expressed as a
system of first order ODE's, the appropriate form for copying directly into
your CAS.
If you have n free accelerations, you will get a set of 2n first order
differential equations, along with 2n initial conditions.
The equations are functions provided by the system. The prefix for the
function names may be set in Edit/ Mechanics Environment
/Differential Equation Prefix.
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Output
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Viewing the Output
The Output settings apply to Symbolic Calculations. The general default
Output settings are found in the Edit / Preferences menu selection,

Math tab -

.

Individual outputs can be adjusted in the Display Properties dialog.
Select the output(s), then invoke the dialog in one of two ways:
·

right click the mouse and select All Properties from the Selection
context menu

·

from the menu bar, select Edit / Properties
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The Output selections specify how the calculations are made and how the
output is displayed.
Use Assumptions - applies to equations containing absolute values.
Use Intermediate Variables - can sometimes simplify the output.
The "Show" check boxes control where the output is displayed.
The check boxes are toggles; when the box is checked the property is
true, when it is clear the property is false.

Assumptions
With the Use Assumptions selection, Mechanical Expressions eliminates
the absolute value from expressions and determines from the diagram
whether the value is positive or negative. Try it with these steps:
1. select

one or more output calculations

2. right click the mouse and select All Properties from the Selection
context menu
3. check the Use Assumptions check box
Obviously, this tool only has an effect when the expression selected
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contains an absolute value.

Intermediate Variables
Substituting intermediate variables can sometimes simplify expressions
calculated by the program. Try this option to see how it affects your
output:
1. select

one or more output calculations

2. right click the mouse and select All Properties from the Selection
context menu
3. check the Use Intermediate Variables check box
If Use Intermediate Variables is unchecked, the Show Intermediate
Variables is inactive.
Note: Intermediate variables are not always used in calculations, in which
case this box will have no effect.

Show Output Check Boxes
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After you generate an output expression:
1. click the output
2. right click the mouse and select All Properties from the Selection
Context menu.
3. when checked, the corresponding output is displayed
Show Intermediate Variables - if the system uses intermediate
variables, their definitions are displayed in the output window.
Show Name - is a term assigned by the system to the output. This name
is zn where n is the sequential number of the output .
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You can change the output name by double clicking the output and
entering a new name in the box.

Show On Diagram - puts the output expression on the diagram when
checked.
Show in Output Window - puts the output expression in the output
window when checked. If this value is checked, then Show Name becomes
active.
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Too Big for Diagram - the output expression is moved to the output
window when checked (Show in Output Window is checked, Show On
Diagram becomes inactive).

Approximation
Converting an output to a numerical Approximation lets you investigate
tolerance sensitivity. The resulting expression is a Taylor series of 1st or
2nd order expanded about the current numerical values of the variables.
Here are the steps.
1. select the symbolic output
2. from the Selection Context menu (right-click) choose All Properties
3. scroll to the bottom of the window and check the Use Approximation
box
4. click the Approximation Order line and the
between Linear and Quadratic.

© 2014 Saltire Software

button to chose

152

Mechanical Expressions Manual

If you have many outputs for using Approximation, you can change the
default setting in Edit / Preferences / Math / Output before you make
your output calculations.
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Using Symbols

The Symbols toolbox lets you easily insert Greek letters into your
expressions and constraints. Click the tab to choose from lower case or
upper case Greek letters. Use the buttons or type the name of the Greek
letter and the symbol will be inserted after you press enter.
The bottom row of buttons in the toolbox lets you insert commonly used
math operations. You can either use the icons, or your type them from
your keyboard:
Symbol
Icon

Function Call / Reserved Word
sqrt(value)
abs(value)
piecewise({expression1, domain1},{expression2,
domain2}...,{last expression, otherwise})
pi

A complete list of built-in functions is detailed below.
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Inserting Greek Letters
To insert Greek letters into any variable name or expression, click the
appropriate tab, Greek Upper (upper case letters) or Greek Lower
( lower case letters) in the Symbols toolbox, and click the letters to be
inserted into the data entry box.

If your Symbols toolbox is hidden, you might want to just type the name
of the Geek letter into your expression. The symbol will be inserted after
you press enter. To get an uppercase Greek symbol, capitalize the first
letter of it's name.

Multiplication & Division Editing Tools
The Multiplication button inserts a multiplication symbol into the
expression.
The Division button makes expressions easier to enter and read.
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From the data entry box, enter the numerator of the expression,
highlight it, and then click Division.

The cursor is then positioned in the denominator.
·

If you click the Division button first, be sure to place the cursor in the
appropriate place before typing the expression.

Square Root Editing Tool
You can enter square roots in one of these ways:
·

From the data entry box, enter the expression you want inside the
square root, highlight the terms, and click the Square Root button.

·

From the data entry box, click the Square Root button, then highlight
the 0 and type the terms.

·

Use the sqrt() function in the data entry box.

Subscript / Superscript Editor
You can enter superscripts or subscripts for variables in one of these
ways:
·

From the data entry box, enter the expression you want sub/
superscripted, highlight the terms and click the Subscript
Superscript
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From the data entry box, click the Sub/Superscript button and type
the values into the grey boxes.

Note: Make sure the cursor is positioned at the left side of the gray
box before typing the sub/superscript.
·

Another way to make a subscript is to use square brackets - A[1] = A1

Parentheses and Absolute Value Notation
You can add parentheses or an absolute value sign to a term in one of two
ways:
·

From the data input box, type the term(s), highlight the term(s), then
click the Parentheses

·

or Absolute Value

From the data entry box, click the Parentheses
Value

button.

or Absolute

button first and enter the terms.

Using the Piecewise Function
A piecewise function or expression can be created using the Piecewise
symbol or the built-in function - piecewise({expression1, domain1},
{expression2,domain2}...,{last expression, otherwise}). The reserved
word, "otherwise" is an option available for the last condition.
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For details see Piecewise Function and Piecewise Parametric Example in the
Creating Functions section.

Built-In Functions
For including in any expression or constraint, MX has the following
common functions available:
Trig
·
·
·

sin()
cos()
tan()

·
·
·

arcsin()
arccos()
arctan()

·
·
·

sinh()
cosh()
tanh()

Math

•
·

sqrt() - same as

·

abs() - same as

signum(x) - finds the sign of a
number:

·

exp(x) - the exponential
function; you must use exp,
not e, e is just a variable name

= -1 if x < 0
0 if x = 0
1 if x > 0
·

log() or ln() - both mean the
natural log

·

piecewise({expression1,
domain1},{expression2,
domain2}...) - the function is
evaluated in the order written

·

diff(expression, variable)

·

integrate(expression, variable)

·

sum(expression, variable =
start, end)

·

ceil() - rounds up

· pi - same as
toolbox

· floor() - rounds down

Boolean

AND

<

OR

<=
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NOT

>
>=

Using Annotation Symbols

Annotation Symbols are available for use with any of the Annotate
tools. These symbols are not used in Mechanical Expressions' algebra
engine, but may be useful in creating worksheets and tests.
Use the symbols from the data entry window of the Annotate tools.
Simply click the symbol you need as you type.
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When you are finished with the annotation, press enter.

Font trouble - some of the Annotation Symbols may not show up in
your drawing, depending on your OS and the default font setting.
(Windows 7 users have no worries.) If you don't see an Annotation
Symbol, change the Edit / Preferences / Math / Annotation / Font /
Face Name. Try one of the Unicode fonts, e.g. Lucida Sans Unicode. If
you are exporting a Metafile, you may have to change the default font in
the program to which you are exporting.

System Variables and Animation
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Investigating Variables

The Variables toolbox reports all the variables you have used in the
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diagram and lets you manipulate their values.

Variables List

This list contains the names of all variables used in your diagram.
For every variable name, the system shows:
·

the current value - these values can be ones that you have explicitly
specified, or just taken from the way you sketched the geometry.

·

lock status - if the variable is locked (+) its value will not change if
you move the geometry or add additional constraints; the unlocked (-)
variable is free to change as the geometry moves or changes.

Functions List
When using the Function command to draw a function of the form Y=f(X)
+g(X), the Functions tab in the Variables toolbox lists the functions f
and g and their values. Use the edit line at the bottom of the box to
modify the functions.
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Using the Lock Tool
By default, when you drag points in a Mechanical Expressions model, it will
adjust the numerical sample values used in the various parameters of the
model to accommodate the drag, as best it can.
For example, in the model of a 4 bar linkage below, dragging point B will
cause lengths a and b and angle q to be adjusted appropriately.
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However, you may want the drag to act as if the members AB and BC
were rigid, and only angle theta adjustable. To do this you can lock the
parameters:

The value of a, for example, can still be set from the Variables panel, but
it will not change when the model is dragged.
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Changing and Locking the Variable Value

To make a change to the variable list, first click anyplace in the row of the
variable you want to change. That row will be highlighted.
To change the value: highlight the value in the edit window and type the
new value.
To change the lock status: just click the button to unlock a locked variable
to lock an open variable

Animation
Your geometry comes to life with the Animation tools. You simply need to
select the parameter that drives the animation, give it a range, then Play.
In the diagram below we select q for the crank of this linkage.
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Click the headings below for details on the animation buttons and
windows:
·

Animation console - works like a video player.

·

Animation modes - indicates how the range for the animation is
stepped through.

·

Animation values and duration - where you specify the speed and the
range for the driving parameter.

Users of numeric interactive geometry systems may be familiar with the
concept of animation based on points animated along line segments or
curves. This type of animation can be conveniently modeled in
Mechanical Expressions using the point proportional along a curve
constraint along with parameter based animation.
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Animation Console

The Animation console works like a standard video
console with the Play, Pause, and Stop buttons as well as advance to
the Beginning and End buttons.

Animation Modes

The animation modes can be changed with the up/down arrow
buttons. The modes are:
Runs the animation one time through the specified range.
Runs the animation continuously from the beginning to the end
of the range.
Runs the animation one time forward and then backward
through the specified range.
Runs the animation continuously forward and then backward
through the specified range.

Animation Values and Duration

These animation buttons help you adjust the range and speed of the
animation.
·

Click and drag the slider along the bar to manually animate the
drawing.

·

In the two data entry windows at the bottom right and left of the
toolbox, specify the range of the animation.

·

The Duration box in the center lets you specify how long the
animation takes to play one time through. Values are between 1 and
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60 seconds.

Animation and the Locus Tool
Both the construction of the locus and envelope curves, and the animation
of the diagram in Mechanical Expressions can be defined in terms of any
variable. For example in the model below, we can create a locus over
values of the variable t (other variables will be kept constant).
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Many of the menus and icons across the top of the screen duplicate the
commands and functions found in the toolboxes.

File Menu
The File menu contains the standard Windows file handling operations
with options for copying and exporting to other programs. Several of the
options are also available from the icon bar.
Menu Option
New
New Graph
Open. . .
Close

Save

Function
Creates a new project.
Graph mode allows scaling of axes.
Brings up the Select a File dialog box so you
can open a project.
Closes the current file or, if multiple files are
open, the file on top.
Saves the file. If you have not yet saved the
current work to a file, the Save File As
dialog box lets you specify where to save the
project file.

Save As . . .

Brings up the Save File As dialog box to
enter a new or different path / file name.
Useful for making a backup.

Open Workbook

Brings up the Open Workbook dialog box.
If any other files are open, they will be closed
when you select the workbook.

Save Workbook

Saves all tabbed pages as a single workspace
(.mxw), so you can open them all at once.

Save Workbook as

Saves all tabbed pages as a single workbook
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(.mxw) and lets you specify a new or
different path / file name for the workbook.
Close Workbook

Closes the current workbook. If you have
made changes to pages, you will be asked if
you want to save them individually (.mx
files).

Export

Export the file as Windows Metafile (.emf) (
Windows version only), image file, an
Encapsulated PostScript (.eps), Scalable
Vector Graphics (.svg), HTML file (.html),
animated gif, JavaScript file, or OS X
Dashboard Widget.

Page Setup. . .

Displays the page setup dialog box for
choosing a printer and print options.
Displays the printout by pages.

Print Preview
Displays the standard system Print dialog.
Print. . .
Recent files

Click to display a list of the most recently
used files. Selecting one opens it.

Exit

Exits the program, after prompting for save.
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Exporting a Drawing

To export your drawing to another program, choose File / Export. You
can export the drawing in the following formats:
Static File Formats

Dynamic File
Formats

· Image - BMP, JPEG,
TIFF, PNG, XMP

· Animated GIF

· Encapsulated
Postscript

· HTML5 /
JavaScript App

· Windows Enhanced
Metafile

· OS X
Dashboard
Widget

· Scalable Vector
Graphics
· HTML
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Please note that neither EMF, nor EPS support semi-transparency or
transparent images of any kind, thus you will get a warning message if
you try to export to either of these formats and you have such an item in
the document.
Here are the steps for the export as an Image file, EPS, EMF, SVG or
HTML:
1. For all file types enter the Filename or click the folder icon to select the
appropriate folder and file.
2. Image files and HTML files have an extra step at this point as detailed
below.

3. Select the region of the drawing with the displayed cursor
(click-and-drag opposite corners of the region).
Animation Files and JavaScript Files have a few more details to consider as
explained below.

Exporting Image Files
When exporting image files, click the down arrow in the Save as type
line to select your desired image format.

Next, set the resolution in the File DPI box. Click the down arrow and
select the appropriate setting or enter a number in the window.
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Exporting HTML Files
When you select File / Export / HTML, the HTML Export dialog
appears.
Fill in the Html Export Settings with optional Title, Header and Footer text.
The Outputs can be renamed to something less obscure than letters with
subscripts. You can give them actual labels using real words. You can
also display your output expressions in many popular CAS input formats
including Content and Presentation MathML.
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Exporting Animation Files
Select File / Export / Animation File to produce an animated gif. This
format is supported by many applications and will enable you to embed
animations in, for example, PowerPoint slides and Wikipedia pages.
Select the directory and file name of your gif, and you will be presented
with a dialog to choose the parameter on which the animation is based,
along with various technical aspects of the animation.

File DPI - specify the resolution of the output. The higher number you
use, the slower will be the process of creating and loading the animation.
Frames Per Second - if you multiply this number by the animation
duration specified in the Variables toolbox, you will get the number of
frames captured. For example if you are set at 10 frames per second,
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and the Variables toolbox specifies the duration of the animation to be 4
seconds, then 40 frames will be captured. The more frames you capture,
the slower will be the animation creation process, and the longer the
animation will take to load.
Number of iterations - when an animation is played (e.g. when a
PowerPoint slide containing the animation is displayed), enter a number
to play the animation a specific number of times, or enter 0 to play it
continuously.
Variable - choose the variable that controls the animation. (All the
variables in the Variables toolbox should be available). The limits of the
variable defining the range of the animation should be set in the
Variables toolbox.

Exporting JavaScript Files
Select File / Export / [HTML5 / JavaScript App] - to export a
Mechanical Expressionsmodel as a JavaScript application (.html file),
within an html page. This can then run within any web browser that
supports HTML 5.
Fill out the details in the JavaScript Applet Generator dialog.
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Output directory - tells MX where to put the files. It will create a file:
name.html in the specified directory. You should be able to bring
name.html up in a browser to see the applet.
Applet Name - is the name of the html file.
Auto-scale - when check, the JavaScript applet automatically rescales the
drawing when the user changes the value of one of the inputs; when
uncheck, you click-and-drag a rectangle around the drawing after you
click Ok.
Width and Height specify the size of the drawing on the html page.
Webpage Title, Webpage Header Text, and Webpage Footer Text - enter
your text for these sections of the applet.
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Since header and footer text may be several lines long, You can go back
and change these text boxes before you close the dialog:
·

select the text entry box

·

click the

·

enter or edit text, then click Ok.

to display the dialog

Note: you can insert html code into the header and footer text, e.g. to
make a word in the footer text bold:

CSS file - lets you add special formatting to your app with your own
Cascading Style Sheet.

Enable Dynamic Simulation - view models with constraints that are free to
move, like a pendulum or a trebuchet. You can insert UI to start and stop
the simulation and set the simulation speed by checking the desired
boxes. If you leave them blank, the simulation starts automatically and
the speed is set by the system.
Inputs - lets you choose which variables the user will be able to change,
what text Label identifies variable and what type of control to use.
Any variables in your MX model may be selected as input variables in the
JavaScript model. See the topic detailing UI Types below.

Outputs - lets you choose which outputs will appear in the applet, and
their text Label.
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See the examplesbelow.

Scaling the App
The Auto-scale checkbox in the JavaScript Applet Generator dialog lets
Mx decide the size of the drawing in the app window. It does this without
knowing how the drawing might move in a simulation, so only check this
box if there is no movement in the app, or if the movement doesn't
change the bounds of the drawing, as in the Brachistochrone example
below.

In the Trebuchet example is one that should not use the Auto-scale
function, we leave the box unchecked. When you finish entering all the
applet details, Mx prompts you to select the drawing area. Remember to
leave enough space around the drawing to account for movement. If you
need to adjust it after the export, just go back to the Mx file. All the
details are saved, so you don't have to reenter them, just do another
export and redraw the boundaries of the model.
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JavaScript Applet Example
We’ll use this MX model, displaying the radius of an incircle to create a
JavaScript Applet.

Here are the parameters we entered in the JavaScript Applet Generator
dialog:
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Here is the result:
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The exported image can be zoomed in and out using the - and + keys on
the keyboard or paned around using the arrow keys. If displayed on a
touch sensitive device, the app supports multi-touch features.
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JavaScript Animated Applet
In this applet, we'll draw a general function, f(x) and then create its
derivative at t (using the Point proportional
MX drawing:

constraint). Here is the

Here are the parameters we entered in the JavaScript Applet Generator
dialog:

© 2014 Saltire Software

184

Mechanical Expressions Manual

Selecting slider for the UI Type of variable t we now have the Go/Stop
button to control the animation of t between the ranges defined in the
Variables panel above.
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To modify the function, simply type a new one in the edit field. A multiline function allows more options.

Dynamic Simulations
When you create a dynamic model with constraints which are Free to
Accelerate, you can make an app of the Dynamic Simulation.
· Make sure your constraint(s) is a single variable, not an expression.
· Optionally, attach an input Velocity - Acceleration to your free
constraint(s). If you do, it will be taken as the initial condition for the
velocity (the acceleration will be ignored, as it is computed from the
diagram). If you don't specify an input velocity, an initial condition of
0 velocity will be assumed. Be sure to output the Resultant
Acceleration of your free constraint(s).
· Check that the Dynamic Simulation checkbox in the JavaScript Applet
Generator dialog is checked.
· Other check boxes:

© 2014 Saltire Software

Menus and Icons

187

Start/Stop button - if you do not check this box, the simulation starts
automatically.
Simulation Speed - you can insert a data entry box to adjust the
speed or let it run automatically (as explained below).

Below the drawing we can list:
·

the inputs

·

a Start/Stop button

·

the Simulation Speed - this value is relative to model speed. The
initial value,1.0, means that the simulation will go at the same
real-time speed as the dynamic model. E.g. a 32 foot long
pendulum, will take 6.28 seconds to complete its cycle. Increase the
speed to 10 and it takes .628 seconds.

·

The Resultant Acceleration, labeled Acc, updates dynamically.
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·

To see a graph of the acceleration values, click

·

Click the icon again and you get a table of values which you can copy
and paste into another program for further analysis:

.
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The Brachistochrone Example
An inverted cycloid curve is the solution to the brachistochrone problem:
providing the quickest path between two points for a ball rolling under
gravity, or a bead sliding on a wire. You can find this model and run the
app (Example 23) in the Examples subdirectory of your Mx installation.
Here are the steps to create the model:
1. Select Draw / Function
and choose Parametric from the Type
window.
2. Enter: X = T+sin(T), Y = -1-cos(T) with T varying from -3.14 to 3.14.
3. Draw / Point

on the curve.

4. Select the point and the curve and choose Point Proportional from
the Constrain toolbox

with a value of t.

5. Select the parameter t and right-click to get the Context menu and
choose Free Constraint to Accelerate.
6. To see the acceleration of the point over time, , select the point and
click Velocity / Acceleration from the Mechanics Output toolbox
.

Your model should appear like this:
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Now you are ready to Export / HTML5 / Javascript App, found in the File
menu.
7. Specify that the app should contain a simulation, give it a start button
(the default has these checked), and set t to be draggable. In the
dialog below, we also clarify the labels.
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You can drag the point along the curve and see its change in acceleration.
Click the down arrow in the acceleration line to see a graph Click the arrow
again to see the table of the output. The App looks like this:
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Trebuchet on Wheels Example
The Mx Examples collection contains a stationary trebuchet example
(Example 19). We modify this example by adding another degree of
freedom to show the recoil of the trebuchet. You can find this model and
run the app (Example 24) in the Examples subdirectory of your Mx
installation.
Here are the steps to creating the model:
1. Draw a line segment over the x axis, but not through the origin.
2. Draw a point at the intersection of the line with the x axis. (You
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)

3. Constrain the distances from each end of the line to the new point (a
and b).
4. Select the point and the x axis and click Point Proportional
in
the Constrain toolbox. Hit enter to accept the default parameter, t.
5. Select an endpoint and click Mechanics Input / Mass
masses M and m to the line's endpoints.

, to apply

6. Select the arm and the x axis to constrain the angle between the two
with the default parameter, .
7. Select
and t, right click, and select Free Constraint to
Accelerate.
8. To see the acceleration of the point over time, , select the point B
and click Mechanics Output/ Velocity / Acceleration in the Real
tab (the symbolic expression is rather involved)

.

Your model should appear like this:

Now you are ready to Export / HTML5 / Javascript App, found in the File
menu.
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9. Specify that the app should contain a simulation, give it a start
button (the default has these checked).
10.Uncheck the Auto-scale box in the Applet Settings section. When
you finish entering all the applet details, Mx prompts you to select
the drawing area. Remember to leave enough space around the
trebuchet in order to see its entire movement.
Here are the app specifications:
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Click the down arrow in the Velocity or Acceleration line to see a graph.
Click the arrow again to see the table of the output. Here's the app:
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To get a smoother graph, decrease the Simulation Speed.

Creating OS X Dashboard Widgets
Dashboard Widgets are very similar to JavaScript Applets, but they sit on
The Mac Dashboard. Select File / Export /OS X Dashboard Widgets.
Fill out the details in the OS X Dashboard Widget Generator dialog.
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Output directory - tells MX where to put the files. It will create a folder:
name.wdgt containing all the components of the widget.
Widget Name - is the name of the folder and the main .html file.
Auto-scale - when check, the Widget automatically rescales the drawing
when the user changes the value of one of the inputs; when uncheck, you
click-and-drag a rectangle around the drawing after you click Ok.
Width and Height specify the size of the drawing in the Widget box.
Widget Title, Widget Header Text, and Widget Footer Text - enter your
text for these sections.
Since header and footer text may be several lines long, You can go back
and change these text boxes before you close the dialog:
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·

select the text entry box

·

click the

·

enter or edit text, then click Ok.

199

to display the dialog

Note: you can insert html code into the header and footer text, e.g. to
make a word in the footer text bold:

CSS file (optional) - you can attach your favorite Cascading Style Sheet,
without having to reproduce it every time.
Inputs - lets you choose which variables the user will be able to change,
what text Label identifies the variable and what type of control to use.
Any variables in your MX model may be selected as input variables in the
Widget. See the topic detailing UI Types below.
Outputs - lets you choose which outputs will appear in the applet, and
their text Label.
Any measurements which are present in the Mechanical Expressions model
may be chosen as outputs for the widget.

UI Types for Applets
JavaScript, Lua Apps and Widgets use identical Input and Output types.
Here are the selections.
Inputs
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Draggable - any points in the Mechanical Expressions model constrained
by variable Coordinates or a variable parameter for the Point
Proportional constraint can be set as Draggable points in the
JavaScript, Lua app or Widget. The point's constraint variables, however,
cannot be functions or negative; only positive variables are allowed for
defining draggable points. I.e., the value of the variable may very well be
negative, but using -t as the point proportional parameter or (x, 3*x) as a
point's coordinates prevents the point from being draggable.
Slider - takes it's range from the values specified in the MX Animation in
the Variables panel.

Please note - not all browsers support sliders.

Text Box - lets you enter any numeric value for the variable.
For a function, you have the choice of a single line Text Box or a Multiline
Text Box. Remember to use the JavaScript return statement in multi-line
statements in JavaScript Apps or Widgets.
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Note: when defining variables or functions in the edit field of
JavaScript Apps or Widgets, remember that JavaScript does not use "^" to
denote a power.

must be written: pow(X,2).

Advance Button - displays the variable Label on a button and
increments the variable when clicked. Uses the range and direction from
the MX animation settings. If you used decimal values in MX, the values a
reduced to integers.
Media Controls - works like the Advance Button but gives you some
additional options. For values within the specified range, you can:
·

increment or decrement regardless of the mode setting

·

jump to a specific integer value by typing (as in the Text Box
mode)

·

jump to the beginning or end of the range

Timer - this is great for making Clock Applets and smooth animations.
Here are the Timer Styles:

© 2014 Saltire Software

202

Mechanical Expressions Manual

The hour, minutes and seconds are taken from your computer's clock.
Random - gives the specified variable a single random value within the
range set in the MX Variables tool panel. To change the variable's value
to another random number click the Reload button

.

Outputs
Any measurements which are present in the Mechanical Expressions model
may be chosen as outputs for the JavaScript, Lua Apps or Widgets. Check
the Show in Export checkbox and modify the Label if needed.

UI Type - Plain Text or Show / Hide Button which is a toggle.
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Graphing Mode
When you need to draw a graph requiring independent scaling of the axes,
select File / New Graph.
·

Draw your graph.

·

Click an axis - the axis will be highlighted and a circular handle
appears.

·

Slide the handle up and down the axis with your mouse.
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Note: Many of the geometry drawing, constraint and construction tools
are unavailable (grayed out) in the Graphing mode for obvious reasons
related to the independent scaling of the axes.

Edit Menu
The Edit menu contains the standard Windows editing operations as well
as ways of dealing with constraint conflicts and all of the program settings.
Several of the options are also available from the icon bar.
Menu Option

Function

When Available

Undo

Reverses actions starting
with the last one.

After any action has
been taken.

Redo

Reinstates actions
starting with the last one
that was undone.

After using Undo

Select

When checked, the select
mode is active.

Select mode is always
active except when
using a Drawing tool or
moving or panning the
drawing.

Select All

Selects everything in the
drawing window.

Always

Select All Type

Presents a submenu of

Always -- most useful
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object types to select.

when the object type is
in the window.

Unselects any objects
that are selected.

Always

Deletes an object, but
saves it so it can be
pasted somewhere else.

An object is selected

Does not delete the
object, but saves is so it
can be pasted
somewhere else.

An object is selected

Displays a submenu of
choices for copying
mathematics into other
programs.

An expression or
formula is selected

Copies everything in the
drawing window as an
Enhanced Metafile (.emf)

Always

Copies a section of the
drawing window inside a
rectangle made by
dragging the cursor.

Always

Copy
Region

Puts whatever has been
cut or copied into the
current drawing

Object(s) cut or copied

Paste

Delete

Deletes whatever is
selected, without saving
it.

One or more objects
selected

Arrange

For placing selected
objects on top of (bring
forward) or underneath
(send backward) other
objects for easier
selection and viewing.

One or more objects
selected

Clear Selection

Cut

Copy

Copy As

Copy
Drawing
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Send to
Mathematica

Inputs the math to
Mathematica when the
algebra system is running
in another window.

Windows version
only

Convert to
Constraint

Tries to convert a
selected output [ 2q] to
an input constraint if
there is no conflict with
other constraints

An output expression is
selected

Convert to
Measurement

Converts the selected
constraint into a
measurement (output)

An input constraint is
selected

Convert to Real

Converts a symbolic
calculation to a real one

A symbolic output is
selected

Convert to
Symbolic

Converts a real
calculation to a symbolic
one

A real output is
selected

Free Constraint
to Accelerate

Frees constraint to create
a dynamic model

An constraint is
selected

Details. . .

Displays the Edit Text
dialog to edit a block of
text

A block of text is
selected

Parameters. . .

Lets you edit the
parameters of functions,
loci and traces.

A function, locus or
trace is selected

Properties. . .

Lets you edit the display
properties of the selected
object(s)

One or more objects of
the same type are
selected

Mechanics
Environment

Sets the default
Mechanics properties.

Always

Preferences . . .

Sets the default
appearance and
properties for the
project's drawing, text
and mathematics

Always

An output expression
or formula is selected
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NOTE: For the Mac version, Preferences are found under the Mechanical
Expressions menu.

Copying Mathematics
To copy expressions or functions into an Algebra system or another
program:
·

Select the math from the Diagram or the Output window.

·

Select Edit / Copy As or right-click the selected expression to
display the submenu of choices for copying expressions or functions
from Mechanical Expressions to another program.
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·

The 2 general types of MathML are available, Content and
Presentation MathML, as well as formats meeting the specific quirks
of several popular Computer Algebra programs.

·

The TeX typesetting output gives you 3 choices in the submenu:Inline
, Display, and Wikipedia. The actual TeX produced is identical, except
for the delimiters which mark the start and finish of the TeX code.

·

There is also a general purpose String output which converts the
selected math into a text string containing no special characters:
is copied as > (((a)^(2)+(b)^(2)+(cos(θ)*b*a*(2))))^(1/2).

·

Generate Source Code from Mechanical Expressions in a number of
different languages:

When you make a submenu selection, the selected math is copied to the
Windows clipboard, ready to be pasted into the appropriate application
(Ctrl+V).
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Generating Source Code
You can generate computer source code from Mechanical Expressions in a
number of different languages.

There are two types of expression in Mechanical Expressions:
·

Scalar

·

Vector

The source code will be in a different form depending on whether there
are intermediate variables present or not.
Note that there is not much difference between the languages in the
mathematical expressions they generate. The main differences are:
·

C#, Java, Javascript, ActionScript, Visual Basic (.net), and Lua
prefixes math functions with “Math.”

·

C / C++ and VBA do not use any prefix for the math functions

Each language has its own way of invoking functions. In the cases where
a vector is returned from the function, the different languages work in
different ways.
·

In C pointers to doubles representing the x and y coordinates of the
vector are passed into the function.

·

In C++, Visual Basic and VBA, references to doubles representing the
x and y coordinates of the vector are passed into the function.

·

In C# double out parameters for the x and y coordinates of the
vector are used.

·

In Java, JavaScript and ActionScript, an array is passed into the
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function, the 0th and 1st elements of the array will acquire the x and y
coordinates of the vector.

Source Code Examples
From the following example we’ll copy the expressions for the location of
point D (a vector) and distance AD (a scalar) in our code generation.

Scalar / No Intermediate Variables
·

Select the distance expression.

·

Right-click and select Copy As / Source Code / C/Objective C

In this case the code generates a single expression (here we are
generating C):
(pow((pow(c,2)+((a+(b*-1))*c)),0.5)*pow((a+b+c),-0.5)*pow(a,0.5)).
Scalar / Intermediate Variables
With intermediate variables showing we get the following for the distance
expression:
double distance(
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double a ,
double b ,
double c )
{
double d_1;
double v_1;
double phi_0;
double d_2;
double d_0;
double u_1;
d_1 =
(pow(((a*-1)+b+c),0.5)*pow((a+(b*-1)+c),0.5)*pow((a+b+(c*-1)),0.5)
*pow((a+b+c),0.5));
v_1 = (d_1*pow(a,-1)*0.5);
phi_0 = ((a+b+c)*v_1*pow(c,-1)*pow(b,-1));
d_2 = (v_1*pow(b,-1)*a*-1);
d_0 = (pow(a,2)+(pow(b,2)*-1)+pow(c,2));
u_1 = (d_0*pow(a,-1)*0.5);
return
(pow(fabs(phi_0),-1)*fabs(d_2)*pow((pow(c,2)+(u_1*c*2)+pow(u_1,2)+
pow(v_1,2)),0.5)*pow(c,-1));
}
We see that the name of the function is the name of the expression in
Mechanical Expressions, its parameters are the input variables, and its
return value is the value of the expression.
Vector / Intermediate Variables
Select the location expression, a vector value, and our function returns
two quantities. This is done in different ways for different languages:
C / Objective C
Pointers to doubles are passed into the function:
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void location(
double a ,
double b ,
double c ,
double *location_x_ ,
double *location_y_ )
{
double location_x;
double location_y;
double d_1;
double v_1;
double d_2;
double d_0;
double u_1;
double phi_0;
d_1 =
(pow(((a*-1)+b+c),0.5)*pow((a+(b*-1)+c),0.5)*pow((a+b+(c*-1)),0.
5)*pow((a+b+c),0.5));
v_1 = (d_1*pow(a,-1)*0.5);
d_2 = (v_1*pow(b,-1)*a*-1);
d_0 = (pow(a,2)+(pow(b,2)*-1)+pow(c,2));
u_1 = (d_0*pow(a,-1)*0.5);
phi_0 = ((a+b+c)*v_1*pow(c,-1)*pow(b,-1));
location_x = (((d_2*-1)+(u_1*d_2*pow(c,-1)*-1))*pow(phi_0,-1));
location_y = (pow(phi_0,-1)*v_1*d_2*pow(c,-1)*-1);
*location_x_ = location_x;
*location_y_ = location_y;
}
C++
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References are passed into the function:
void location(
double a ,
double b ,
double c ,
double &location_x_ ,
double &location_y_ )
{
double location_x;
double location_y;
...
location_x_ = location_x;
location_y_ = location_y;
}
C Sharp
Out parameters are passed into the function:
void location(
double a ,
double b ,
double c ,
out double location_x_ ,
out double location_y_ )
{
double location_x;
double location_y;
...
location_x_ = location_x;
location_y_ = location_y;
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}
Visual Basic / VBA
References are passed into the function:
Sub z_0(ByVal a As Double , ByVal b As Double , ByVal c As Double ,
ByRef z_0_x_ As Double ,ByRef z_0_y_ As Double )
Dim z_0_x As Double
Dim z_0_y As Double
…
z_0_x_ = z_0_x
z_0_y_ = z_0_y
End Sub
Java
An array of doubles of size 2 is passed in and populated by the function:
double location(
double a ,
double b ,
double c ,
double[] location_v )
{
double location(
double a ,
double b ,
double c ,
double[] location_v )
{
double location_x = 0;
double location_y = 0;
...

© 2014 Saltire Software

Menus and Icons

location_v[0] = location_x;
location_v[1] = location_y;
}
JavaScript
An array is passed in and populated by the function:
function location(
a,
b,
c,
location_v )
{
var location_x = 0;
var location_y = 0;
...
location_v[0] = location_x;
location_v[1] = location_y;
}
Action Script
An array is passed in and populated by the function:
public function location(
a:Number ,
b:Number ,
c:Number ,
location_v:Array) )
:void
{
var location_x:Number;
var location_y:Number;
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…
location_v[0] = location_x;
location_v[1] = location_y;
}

Free Constraint to Accelerate
To create a dynamic model in Mechanical Expressions, you need to first
create a static model, specifying constraints which will bear the load of any
unbalanced forces. You then need to specify which of these constraints
are in fact free to accelerate. You do this by selecting the constraints then
using the right click menu option or the Edit menu option. When the
constraint is free to accelerate you will see a small unlocked icon.
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If a constraint has an input velocity and acceleration, and is made free to
accelerate, then the input acceleration is not used. Instead an acceleration
is computed for the constraint based on the existing force elements and
mass elements. This computed acceleration is used in calculating other
mechanics outputs, such as reaction forces, velocities and accelerations.

If you measure the resultant acceleration of a constraint, the system
automatically frees that constraint. If you then delete the resultant
acceleration, the constraint is still left free to accelerate. To stop the
constraint being free to accelerate, you need to toggle it off using the right
click or the Edit menu.

View Menu
The table below lists the complete summary of View functions.
Menu Option
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Hide

Hides a selection

One or more elements
are selected.

Show all

Displays any entities that
were hidden

One or more elements
are hidden.

Lets you toggle hidden /
visible for any object in
the drawing

Always (if the drawing
window isn't empty)

Zoom In

Makes the drawing details
larger without affecting
the size on the printed
page. (The text gets larger
on the screen.)

Always available (most useful when
there is something in
the drawing window).

Zoom Out

Makes the drawing details
smaller without affecting
the size on the printed
page. (The text gets
smaller on the screen.)

Always available (most useful when
there is something in
the drawing window).

Zoom To
Selection

Lets you make a selection
and adjusts it to fit the
drawing window. (The text
gets larger on the screen.)

Always available (most useful when
there is something in
the drawing window).

Zoom To Fit

The entire diagram is
displayed in the drawing
window. (The text size
changes with the
geometry.)

Always available (most useful when
there is something in
the drawing window).

Zoom To Page

The whole page is
displayed in the drawing
window. (The text size
changes with the
geometry.)

Always available (most useful when
there is something in
the drawing window).

Allows you to move the
contents of the drawing
window without changing
its position on the page.

Always available either Pan View or
Move Geometry will
be in effect (checked).

Toggle
Hidden

Pan View
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Enlarges only the
geometry. (The text size
on the screen doesn't
change.)

Always

Scale
Geometry Up

Shrinks only the
geometry. (The text size
on the screen doesn't
change.)

Always

Scale
Geometry Down

Scale
Geometry To
Selection

Lets you select a portion
Always
of the geometry and
adjusts it to fit the drawing
window (The text size on
the screen doesn't
change.)
Adjusts all geometry to fit
in the drawing window.
(The text size on the
screen doesn't change.)

Always

Scale
Geometry To Fit

Adjusts all geometry to fit
inside the specified page
boundaries. (The text size
doesn't change relative to
the page.)

Always

Scale
Geometry To
Page

Move
Geometry

When checked, click and
drag to move the drawing
contents with respect to
the page boundaries.

Always. Make sure
Page Boundaries is
checked (below) to
see the results.

When checked, the axes
are displayed. They have
the properties of Infinite
Lines.

Always

When checked, the grid is
displayed.

Always

Page Boundaries When checked, the page
boundaries are displayed.

Always

Axes

Grid

Tool Panels
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When checked, the
toolboxes are displayed on
the screen.
Tool Panel
Configurations

Gives you options for
arranging the toolboxes to
your preference.

Output

When checked, the output
window is displayed.

Language

The current version of
Always
Mechanical Expressions
can be displayed in
English, French,
German, Spanish, Polish
, or Russian. Choose one
and restart the program.

Always

Checked menu options are toggles:
·

Checked indicates the option / mode is active or displayed.

·

Unchecked indicates the option / mode is inactive or hidden.

·

Except Pan View and Move Geometry where one or the other is
checked.

Click the selection to change its state.
Some menu items have icon shortcuts found on the icon bar at the top of
the screen.

Zooming and Scaling
The View menu has Zoom operations pertaining to the screen view, and
Scale operations pertaining to the page view.
·

Zooming makes the drawing details smaller without affecting the size
on the printed page. The text (constraints, output and annotation)
changes size with the rest of the drawing.

·

Scaling adjusts the size of the geometry relative to the page, but the
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text doesn't change size in the drawing window. Check View / Page
Boundaries to see this work.
The Scale functions used from the icon bar at the top of the screen can be
changed to Zoom functions by holding the ctrl key while clicking the icon.
This is handy if you need to change the size of the text on the screen:
·

A Scale down
followed by a Zoom in [ctrl]
of enlarging the text.

·

A Zoom out [ctrl]
followed by a Scale up
shrinking the text on the screen.

has the effect

has the effect of

Toolbox Menus
The menus with the same name as the toolboxes at the side of the screen
just give another way of accessing the same functions.
Menu Option

Selection

Draw

Point

Line Segment

Infinite Line

Vector

Polygon

Circle

Ellipse

Parabola

Hyperbola

Arc

N-gon

Curve
Approximation

Text

Picture

Expression

Angle

Distance /
Length

Coefficients

Coordinate

Radius

Expression

Direction

Slope

Distance /
Length

Radius

Function
Annotate

Constrain
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Construct

Calculate

Angle

Direction

Slope

Coordinate

Coefficients

Tangent

Incident

Congruent

Parallel

Equation

Proportional

Midpoint

Intersection

Perpendicular
Bisector

Angle Bisector

Parallel

Perpendicular

Tangent to
Curve

Polygon

Reflection

Translation

Rotation

Dilation

Locus

Trace

Area Under Arc

Distance /
Length

Radius

Angle

Direction

Slope

Coordinates

Area

Perimeter

Coefficients

Parametric
Equation

Implicit Equation

Stop
Calculations

Start
Calculations

Help Menu
The Help menu lets you access this help system, check for updates,
change the program's language, and gives you information about the
program's license and version.
The menu selections are always available.
Menu Option

Function

Dynamic Help

Invokes the Help system
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Contents. . .

Look in the Table of Contents; add new or refer to
saved bookmarks.

Index. . .

Look in the Help index. There is also a facility to
Search index headings.

Search. . .

Search the Help topics for keywords.

License. . .

Displays information about your license.

Check for
Updates. . .

Prompts you to save your work, checks for new
versions of Mechanical Expressions, then restarts
the program.

223

Contains the current version of the program, the
copyright notice, and the link to Mechanical
Expressions' website.

About. . .

NOTE: For the Mac version, About... is listed under Mechanical
Expressions menu.

Context Menus
Context Menus pop up when you right-click with the cursor positioned
anywhere in the drawing window.
·

The general context menu - appears when you right click and nothing
is selected.

·

The selection context menu - appears when one or more elements in
the drawing window are selected. Some menu entries my be inactive,
depending on which elements are selected.

The General Context Menu
Right-click anywhere in the drawing window to display a context menu. If
nothing in the window is selected, the menu choices are the following:
Menu Option

Function

When Available

Close

Closes the current file

Always
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Save

Updates a file that already
exists

The file has been
saved

Save As. . .

Saves a file for the first time
and prompt for the filename
and path

Always

Select All

Selects everything in the
drawing window

Always

Select All Type

Presents a submenu of
object types to select.

Always -- most useful
when the object type
is in the window.

Copies everything in the
drawing window as an
Enhanced Metafile (.emf)

Always

Copies a section of the
drawing window inside a
rectangle made by dragging
the cursor.

Always

Copy
Region

Paste

Puts whatever has been cut
or copied into the current
document

Object(s) cut or
copied

Displays any entities that
were hidden

One or more element
(s) are hidden

Lets you toggle hidden /
visible for any object in the
drawing

Always

Stop current calculations

A calculation isn't
finished

Restart any stopped
calculations

A calculation is
stopped by user

Allows you to change the
Grid and Background Display
Properties

Always

Copy
Drawing

Show All

Toggle
Hidden
Stop
Calculations
Start
Calculations
Display
Properties
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Toggling - Hide / Show Elements
From the general context menu select Toggle Hidden. The magic wand
cursor appears, and any hidden objects appear faintly in the drawing
window.

Click faint items to display them. Click any displayed items to hide them.
When you are finished toggling, click the select arrow

.

Selection Context Menu
Select one or more model elements and right-click anywhere in the
drawing window to display a context menu. Selection context menus
contain some subset of the following list.
Menu Option
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Cut

Deletes an object, but saves it
so it can be pasted somewhere
else

One or more
objects selected

Copy

Does not delete the object, but
saves is so it can be pasted
somewhere else

One or more
objects selected

Copy As

Displays a submenu of choices
for copying mathematics into
other programs

An expression or
formula is
selected

Send to
Mathematica

Inputs the selected expression
to Mathematica when the
algebra system is running in
another window

An output
expression or
formula is
selected

Puts whatever has been cut or
copied into the current
document

Object(s) cut or
copied

Delete

Deletes whatever is selected,
without saving it.

One or more
objects selected

Hide

Makes the selected objects
invisible

One or more
objects selected

Edit
Parameters...

Lets you edit the domain of a
polar or parametric function or
the parameters of a locus or
trace.

A function, locus,
or trace is
selected

Arrange

For placing selected objects on
top of (bring forward) or
underneath (send backward)
other objects for easier
selection and viewing

One or more
objects selected

Constrain
(Input)

Displays a submenu identical
to the one in the same dropdown menu on the Menu Bar

Geometry
selected

Free Constraint
to Accelerate

Frees constraint to create a
dynamic model

An input
constraint is

Paste
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selected
Construct

Displays a submenu identical
to the one in the same dropdown menu on the Menu Bar

Geometry
selected

Calculate
(Output)

Displays a submenu identical
to the one in the same dropdown menu on the Menu Bar

Geometry
selected

Visibility
Condition

Lets you enter an equation
specifying when the selected
object(s) are visible.

One or more
objects selected

Point Properties

Lets you change the selected
point's color and size

One or more
points selected

Arrow Head

Lets you turn off or change the
arrow head style of the
selected segment(s)

One or more
segments
selected

Line Properties

Lets you change the selected
line's color, style, and
thickness

One or more
objects created
with lines or
segments

Fill Properties

Lets you change the color,
Polygon, N-gon,
style, and transparency level of filled circle, filled
the selected object(s)
ellipse, picture or
trace selected

Pinned

Lets you pin / unpin the
selected object(s)

Text, picture, or
expression
selected

Text Properties

Lets you change the selected
text's color, size, and style

Text, label,
expression,
constraint, or
measurement
selected

Show Symbol

A toggle to display or hide the
selected object(s)

Constraints,
annotations, or
measurement
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lines selected
Output
Properties

Lets you turn on or off the
selected output's name,
assumption or intermediate
variables

One or more
outputs selected

Show
Arrowheads

Lets you turn on or off the
selected angle symbol's
arrowheads

One or more
angle symbols
selected

Congruence
Style

Lets you change the angle
style from arcs to tics and vice
versa

One or more
angle or
congruent angle
annotations
selected

Tic / Arc Count

Lets you change the number of
tic/arc counts of selected
annotations

One or more
congruent,
congruent angle,
or parallel
annotations
selected

Axes Properties

Lets you turn the labels on the
axes on/off or change the
number of subdivisions or units
to display

One or both axes
selected

All Properties. . . Lets you edit the display
properties of the selected
object(s)

One or several
similar objects
are selected

[Convert to
Calculation
(Output)]

Deletes the selected constraint
and calculates the equivalent
output

A constraint is
selected

[Convert to
Constraint
(Input)]

Changes the calculation to an
input constraint

An output
expression is
selected

[Convert to
Real]

Changes a symbolic output to
a real output value

A symbolic output
expression is
selected
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[Convert to
Symbolic]

Changes a real output value to
a symbolic output expression

229

A real output
value is selected

Axes Display Properties
The Axes Display can be set in the default settings, Edit / Preferences
under the Grid, Axis, Page tab, or you can change them for an individual
drawing from the Selection Context menu.
To invoke the Selection Context menu:
1. Select one or both axes
2. Right click the mouse

The All Properties selection brings up all the Display Properties dialog
for the axes.
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You can configure the X and Y axes in many ways. There are the usual
attributes of lines and text.
Show Labels - is useful when the axis labels lie under some part of your
diagram making it hard to read. You can turn these off on one or both
axes with the attribute set to False.
Units - can be set to the usual decimal, but with trig functions you may
find the Degrees, Radians or Radians/3 units more appropriate.
If you
use the Degrees or Radians units in trig functions, don't forget to set your
Angle Mode to Radians on the status bar.
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Visibility Condition
You can set any mathematical condition for one or more object's visibility.
Use this with the Animation tools for some great effects. Here are the
steps:
1.

Select the object(s) that you want to change visibility.

2.

Right-click and select Visibility Condition from the Selection
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Context menu.
3.

Enter the expression for a defined variable for which you would like
your object(s) to be visible.

Here's an example. Point C is t proportional along the parabola. In the
first figure the picture is hidden. When the picture was visible, we set the
it's Visibility Condition to: |t| >=0 AND |t| <.3 . With the Animation
tools we set t from -1.5 to 1.5. As point C approaches the top of the arc,
BOOM!

Tool Bar
The icons across the top of the screen make some of the routine tasks in
the File, Edit, and View menus, and Help easily accessible.
- See The Selection Arrow for more information.
- See File Menu for more information.
- See Edit Menu for more information.
- See View Menu for more information.
- See Output Calculations for more information.
Invokes the embedded Help facility
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Where is the Mechanical Expressions Website?
Information on purchases and additional technical support can be found on
the Mechanical Expressions website at: www.MechanicalExpressions.com.
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.emf 172
.gx 38
.gxw 38
.jpg 172
.png 172
.tiff 172
.xmp 172

-33-D drawing

117

-Aabsolute value notation 156
Acceleration
Resultant 144
ActionScript 209
Actuators 138
adjusting
drawing 79
text size 220
angle
annotation 118
bisector 104
calculate 129
constraint 89
mode 17
supplement 129
animation 164
console 166
duration 166
export file 175
modes 166
parameter based 167
values 166
with Locus tool 167
annotation 115
angle 118
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coefficients 121
congruent 122
congruent angle 122
coordinate 120
direction 119
distance 116
distinguish from constraints 82
expression 125
length 116
parallel 124
perpendicular 117
radius 117
slope 120
symbols 158
text 63
Applets 176
Inputs 199
Multiline Text Box 185
Outputs 202
UI Types 199
Applied Force 136
Applied Torque 136
Approximation of Symbolic output 151
Arcs 56
Area between curves 57
area calculation 132
area under the curve 114
arranging Mx files in the drawing window
assumptions 147
axes 49
display properties 229
scaling 203
units 229

-BBackground color 30
bisector
angle 104
perpendicular 103
Brachistochrone problem 189
built-in functions 153, 157

-CC 209
C# 209
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C++ 209
calculations 126
angle 129
area 132
coordinates 132
direction 131
distance / length 127
implicit equations 134
parametric equations 134
perimeter 133
radius 128
slope 131
vector coefficients 133
Calculus 114
check boxes 148
circles 52
coefficients
annotation 121
constraint 91
conflicts, constraint 85
congruence 93
angle annotation 122
annotation 122
constraints 80
angle 89
changing 81
conflicts 85
congruent line segments 93
coordinate 91
direction 90
distance 87
distinguish from annotations 82
equation 95
incident 92
length 87
parallel line segments 94
perpendicular 88
point proportional along curve 95
radius 88
slope 90
system added 82
tangents 92
vector coefficients 91
constructions 100
angle bisector 104
area under arc 114
dilation 108
intersection 102

locus of points 109
midpoints 102
parallel 104
perpendicular bisector 103
perpendicular lines 105
reflection 106
rotation 107
tangent 105
trace 111
translation 107
Context Menus 223
Visibility Condition 231
Convert to
Input / Output 225
Symbolic / Real 225
coordinates
annotation 120
calculation 132
constraint 91
copy and paste mathematics 42
Copy As
mathematics 207
MathML input 207
Source Code 209
String input 207
curve approximations 62
Curvilinear polygon 57

-DDampers 138
Dashboard Widgets
Defaults 28
Mechanics 34
text font 64
degrees 17
differential equations
dilation 108
direction
annotation 119
calculate 131
constraint 90
Display 16
arranging pages
Background color
configuration 23
customizing 20

197

144

24
30
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Index
Display 16
output properties 146
Settings 28
distance
annotation 116
calculation 127
constraint 87
Distinguish Constraints / Annotations
division editing tool 154
drawing
adjusting 79
arcs 56
circles 52
constraints 80
curve approximations 62
ellipses 53
expressions 66
hyperbola 55
line segments 48
lines 49
parabolas 54
points 47
polygons 51
Preferences and Properties 46
regular polygons 61
text 63
tools 46
vectors 50
Dynamic Simulations 186
Brachistochrone 189
Trebuchet on Wheels 192

-EEdit Menu 204
Copy As 207
Preferences 28
Settings 28
Ellipse 53
envelope 109
Equations
constraint 95
implicit 95
implicit: calculating 134
equations of motion 144
examples 44
exporting drawings 172
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82

Animation files 175
HTML 174
Image files 173
JavaScript Applet animated example
JavaScript Applet example 180
JavaScript files 176
widgets 197
Expression
annotation 125
Draw tool 66

-FFile Handling 38
workbooks & individual files
File Menu 170
Export 172
force on a pin 142
functions 67
built-in 153, 157
cartesian 68
domain 71, 73
f(X) 70
handles 68, 71, 73
list 161
parametric 73
piecewise 75
polar 71

-GGraphing mode 203
Greek letters 154

-Hhelp
using the Help system
Help Menu 222
Hide, toggle 225
HTML export files 174
Hyperbola 55

-IIcon Bar
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image export 172
Image export files 173
incidence 47, 92
Inputs
constraints 80
Mechanics 135
integrals 114
intermediate veriables 148
intersections 102

-JJava 209
JavaScript export files 176
animated example 183
Dynamic Simulations 186
example 180
using multi-line functions 183
JavaScript, Source code 209

-Llength
annotation 116
calculation 127
constraint 87
line
infinite 49
intersections 102
parallel construction 104
segments 48
linked text 13
locking variables 164
using the lock 162
locus of points 109
curves and animation 167

-MMass 137
MathML 42, 207
Matlab 209
Mechanics
Environment settings
Mechanics Inputs 135
Applied Force 136
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Applied Torque 136
Applied Velocity - Acceleration 140
Mass 137
Moment of Inertia 137
Spring - Damper - Actuator 138
Mechanics Output 141
Differential Equations 144
Mechanics Outputs
Pin Reaction 142
Reaction Force 141
Resultant Acceleration 144
Velocity - Acceleration 143
Menus
Annotate 115
Calculate (Output) 126
Constrain (Input) 80
Construct 100
Context 223, 225
Draw 46
Edit 204
File 170
Help 222
View 217
Metafile 172
midpoints 102
Moment of Inertia 137
move the drawing 79
multiple drawings 38

-NN-gons

61

-OObjective C 209
output
Approximation 151
Assumptions 147
calculations 126
check boxes 148
Mechanics 141
name 148
properties 146
window 217
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Index

-P-

-S-

page tabs 38
pages
arranging 24
Parabola 54
parallel 94
annotation 124
construction 104
parametric equations
output 134
Parametric Variable 109, 111
parentheses for math notation 156
perimeter calculation 133
perpendicular
annotation 117
bisector 103
constraint 88
construction 105
Pictures 65
Piecewise Functions 75
parametric example 76
Pin reaction force 142
points 47
constrained along a curve 95
polygons
construction 106
drawing 51
regular 61
Preferences 28
Properties
Axes 229

Scale 79, 220
scaling the axes 203
screen layout 16
selecting
geometry 77
multiple objects 78
Settings 28
Mechanics 34
Show Output 148
slope
annotation 120
calculate 131
constraint 90
Smartboard Mode 78
source code
Copy As 209
examples 210
Springs 138
square root editing tool 155
status bar 17
subscript / superscript 155
Supplemetary Angles 129
symbols 153
division 154
Greek letters 154
parentheses & absolute value
square root 155
subscript / superscript 155

-Rradians 17
radius
annotation 117
calculate 128
constraint 88
Reaction Force 141
Reflection 106
reserved words 153
Resultant Acceleration
rotation 107
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-Ttangents 92, 105
text 63
Edit Text dialog 64
size 220
tolerance sensitivity 151
Toolbox Menus 221
toolboxes
arranging 21
configuration 23
floating / anchored 21
hiding / showing 22
Trace 111
translation 107

156
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Trebuchet example

192

-Vvariables 160
functions list 161
list 161
locking 164
value 164
VBA 209
vectors
calculate coefficients 133
constraints: coefficients 91
drawing 50
Velocity - Acceleration
input 140
output 143
View Menu 217
Visibility Condition 231
Visual Basic 209

-WWidgets 197
Workbook files 39
workspace 38

-ZZoom

79, 220
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